7 =i HCS™

/ BEl® Streets Reliability Module

USER GUIDE

Transportation Institute‘ M 7_
UF UNIVERSITY of FLORIDA c r a ns



Contents

Introduction 1
LICENSE AGIEEIMENT ...ttt ettt e e e st e e s bt e e e e st e e e e s sbeeeesanreeeeaes 1
ACKNOWIEAGEMENTS ... et e e b e e e e 6
Trademarks and COPYHIGNTS ........c..uiiiiiie e e e e e e e e e e e e e e senrnreees 6

Getting Started 7
SystemM REQUIMEMENTS ..ottt e e e e e e et e e e e e e e s ae e e e e e e e e annneeeaaeeas 7
LCT=) o[RS =y (Yo [F USSR 7

General Controls 8
LY TU ) (= o SR 8

Urban Street Reliability 10
[ (0317 01 4 F= T o (=Y e A PSR 10
L@ oT=T = 11 o] gF= N - | = LSS 11
Urban Street Reliability REPOM..........ooiiii e s 15

How To 16
Create @ NEBW FilB ... et e e e enb e e e st e e e e b e e e eneeas 16
Open an EXIiSHING File ..o e e 18
RS T= Y= 1= 22
L0 0 TST = T 1 SRS 24
EXIt the Program..... ..ot 24
Edit the Default SettiNgs .......oouiiiii e 26
LOAA @ BASE FilE ... e e 27
Load ReQiONal WEALNET ..........ueiiiiiiiiiii ettt e e ee e eeeeeeeeeeeeeeeeeeeeeeeeaaaaaaeaeeaaes 30
LCT=T LT = | (SIS ToT =Y o= 4 o LSS 32
View ReSUIES Of the ANAIYSIS ...ccoiiiiiiiiiiiiee e e e e e e st e e e e e e e anes 37
T = T =T oo o PSSP 42

Glossary of Terms 45

Index 58

ii - Contents Streets Reliability User Guide



Introduction

License Agreement

HIGHWAY CAPACITY SOFTWARE™ (HCS™)
END-USER LICENSE AGREEMENT (EULA)

Effective Date: 10/15/2024

Copyright © 2024 University of Florida. All rights reserved.

This End User License Agreement (“Agreement”) is a legal agreement between you (“End User”, “you”) and the
University of Florida Board of Trustees for the benefit of the McTrans Center (“McTrans”, "we”) regarding the use
of the Highway Capacity Software (“Software”). By accessing or using the Software programs within the
electronically transmitted package or direct download, you agree to be bound by the terms and conditions of this

Agreement.

1. INTEGRATION:

This License Agreement is the complete and exclusive statement of the agreement between End User and McTrans
and supersedes any previous End User License Agreements distributed by older versions of the software proposal
or prior agreement, oral or written, and any other communications between End User and McTrans relating to the
subject matter of this License Agreement. This EULA will supersede the End User License Agreement contained in
the HCS Version 5, 6, and 7 modules disseminated as part of the Software. This License Agreement may only be
modified by a written agreement made subsequent to the date hereof and signed by both parties.

2. LICENSE GRANT:

2.1 Subscription-Based License:

McTrans grants you a non-exclusive, non-transferable license to access and use the Software, subject to the terms
of your active subscription. The license is valid only for the duration of your subscription and is contingent upon full
payment of all applicable fees.

2.2 Access to Software Versions:

Your subscription grants access to versions 5 (selected modules), 6 (selected modules), 7 and 8 series and beyond
(2022 onward) of the Software. When a new version of the Software is released, the End User with an active
subscription can download and access the latest version at no additional cost for the remainder of their subscription
term.

3. TYPES OF SUBSCRIPTIONS:
The type of subscription determines the permitted use of the Software. Once a subscription type is selected, it
cannot be changed or exchanged for a different type.
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3.1 Office-Based Subscription:

This subscription grants access to the Software for a predetermined number of computers within a physical office.
An "office" refers exclusively to a fixed geographical location, typically a single physical address, where an
organization conducts its business or operational activities. This location must consist of one or more contiguous
rooms or spaces within a single building. Virtual offices or any non-physical locations are excluded from this
definition.

The Software may be installed on multiple devices within the office, and access is restricted to end users officially
assigned to that licensed office. End Users may also use the Software on portable computers, such as laptops,
while on official travel, provided that all (100%) such use is exclusively on behalf of the office for which this Software
license was purchased. Additional offices must obtain proper licensing prior to accessing the Software. The
Software may only be installed on devices owned or controlled by the licensed office.

This subscription is intended exclusively for commercial use.

Virtualization Restriction:

The Software under an office-based subscription is prohibited from being used in a virtualized environment. All
installations of the Software must be conducted on a physical computer, such as a desktop or laptop. Remote
access technologies, such as remote desktop, are strictly prohibited under this subscription type.

3.2 Computer-Based Subscription:

This subscription permits the installation and use of the Software on a specified number of individual devices. An
"individual device" refers to a single, standalone computing unit, such as a desktop or laptop, intended for use by a
single user at a time. It is not shared concurrently with other users and is intended for use by a single user only The
Software may only be accessed directly from the device(s) on which it is installed, regardless of whether the device
is located in a physical office or used in a virtual office. End users working remotely or in virtual offices must ensure
that the device remains dedicated to their use and fully complies with the terms of this subscription.

Virtualization Restriction:

The Software under a computer-based subscription is prohibited from being used in a virtualized environment. All
installations must be conducted on a physical computer, such as a desktop, PC, or laptop. Remote access to the
Software via any technology, including but not limited to remote desktop, is strictly prohibited under this subscription
type.

3.3 Academic Subscription:

The academic subscription is available exclusively to academic institutions and grants access to a specified number
of seats (copies) across the entire academic institution. This subscription is intended solely for use in a classroom
setting for teaching or a lab for research purposes under the direct supervision of faculty or other authorized
personnel. The Software may only be installed on devices owned or controlled by the academic institution.

The End User is required to implement appropriate protection measures to prevent students or any other individuals
from copying the Software and removing it from the lab or classroom environment. The responsibility for
safeguarding the Software and preventing unauthorized copying or distribution rests entirely with the End User.

Virtualization for Virtual Classrooms:

Under the academic license, the End User may request permission to utilize a virtual environment for the installation
and use of the Software. Such virtualization is only permitted with prior written consent from McTrans. If such
permission is granted, the virtual environment must adhere to all protections and restrictions outlined in this
Agreement, ensuring that the Software is used exclusively for its intended educational purposes and its access is
limited to the institution's faculty and actively enrolled students only. Additionally, the number of seats purchased
must be sufficient to cover the number of students and faculty accessing the virtual classroom.
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4. SUBSCRIPTION TERM:

4.1 Duration:

The subscription term begins on the date of purchase and continues for the period specified at the time of purchase
("Subscription Term"). The license granted under this Agreement is valid only for the duration of the Subscription
Term.

4.2 Renewal:

Subscriptions may be renewed upon payment of applicable fees before the end of the Subscription Term. If the
subscription is not renewed, access to the Software and all related services, including technical support, will be
terminated.

5. TECHNICAL SUPPORT:

5.1 Support Services:

During the active Subscription Term, the End User is entitled to reasonable telephone or email support provided
during the normal business hours of McTrans. McTrans reserves the right to determine the extent of the support
provided.

5.2 Revisions and Enhancements:

McTrans reserves the right to make substantial revisions and enhancements to the Software and to market such
substantially revised versions as separate products. The End User shall not be entitled to receive such separate
products without additional charge. Upon the release of any such revised version of the Software, the obligation to
provide the above-described technical support services to the End User shall cease unless the End User chooses
to pay to license the enhanced version of the Software, regardless of whether the End User has previously
requested or received support on the prior version.

6. NETWORK USE:

The End User is strictly prohibited from using the Software on any network. This prohibition includes but is not
limited to the use of the Software either directly or indirectly through commands, data, or instructions transmitted to
or from a computer that is not licensed or is not part of the licensed internal network. This also includes any use for
Internet or web hosting services or by any user who does not hold a valid license for the Software from McTrans.

The Software is not designed for network use, and such use is unsupported. McTrans will not provide technical
support for any issues resulting from network incompatibilities or unauthorized network use.

7. RESTRICTIONS ON USE
The End User agrees that they shall not, nor shall they permit any third party to:
e Software Modification: Modify, adapt, translate, or create derivative works based on the Software, in whole
or in part, without the express prior written consent of McTrans.
e Reverse Engineering: Reverse engineer, decompile, disassemble, or otherwise attempt to derive the
source code of the Software, except to the extent expressly permitted by applicable law.
e Unauthorized Use: Use the Software for any purpose other than as expressly permitted under this
Agreement, including unauthorized copying, distribution, or dissemination of the Software.
e Intellectual Property Infringement: Engage in any activity that infringes on the intellectual property rights of
McTrans, including any unauthorized copying or distribution of the Software or associated documentation.
e Copying and Distribution: Copy, reproduce, or distribute the Software or associated printed documentation
for sale, distribution, or dissemination, except as expressly provided under the terms of this Agreement or
with the express prior written consent of McTrans.
e Documentation Use: Reproduce the associated documentation only as necessary for use within the
permitted scope of the subscription type as outlined in this Agreement.
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Ownership of Software Modifications:

Any modifications, adaptations, translations, derivative works, or any other products or materials resulting from any
prohibited actions shall become the exclusive property of McTrans, regardless of whether such actions were
performed with or without McTrans’ consent.

8. INTELLECTUAL PROPERTY RIGHTS:
The Software and all associated intellectual property rights are owned by McTrans. No rights are granted to the
End User other than the limited license expressly set forth in this Agreement.

9. USE OF RESULTS IN RESEARCH AND COMMERCIAL PUBLICATIONS:

McTrans grants the End User legal permission to use the results generated by the Software in academic, research,
or commercial publications, provided that such use complies with the terms of this agreement. The End User may
publish or present findings derived from the Software as part of their research or commercial work as long as the
Software is properly cited and all applicable license terms and restrictions are adhered to. Unauthorized
reproduction or distribution of the Software itself remains strictly prohibited.

10. TRANSFER RESTRICTIONS:

The Software is licensed only to the End User, and this License Agreement may not be assigned or transferred to
anyone without McTrans’ prior written consent. Any authorized transferee of this License Agreement shall be bound
by the terms of this License Agreement. The End User may not transfer, assign, rent, lease, sell, or otherwise
dispose of the Software except as expressly provided in this License Agreement.

11. LIMITED WARRANTY AND LIMITATIONS OF REMEDIES:

End User acknowledges and agrees that it is the sole responsibility of End User to fully understand the limitations
and assumptions underlying the Software and to refrain from using the Software without the assistance of personnel
with appropriate expertise. The End User accepts full responsibility for reviewing, interpreting, applying, and utilizing
the output of the Software and for ensuring that such output complies with any applicable design codes, standards,
or project specifications.

Except as expressly provided herein, the Software is provided “AS IS” without warranty of any kind, whether
expressed or implied, including, but not limited to, implied warranties of merchantability and fitness for a particular
purpose. McTrans does not warrant that the functions contained in the Software will meet the End User’s
requirements or that the operation of the Software will be uninterrupted or error-free. The entire risk as to the quality
and performance of the product is with the End User.

In no event will McTrans be liable to the End User for any damages, including any lost profits, lost savings, or other
incidental or consequential damages arising out of the use of or inability to use the Software, even if McTrans has
been advised of the possibility of such damages, or for any claim by any other party. The above warranty gives the
End User specific legal rights, and the End User may also have other rights in the United States, which vary from
state to state.

Use of the Software where the End User believes or has reason to believe that damage may occur constitutes a
violation of any and all warranties. McTrans has no knowledge of the hardware or Software configurations of the
End User and assumes no liability for their damage.
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12. TERMINATION:

12.1 Termination by McTrans:

McTrans may terminate this Agreement immediately upon notice if you fail to comply with any term or condition of
this Agreement. Upon termination, you must cease all use of the Software and destroy all copies of the Software in
your possession.

12.2 Termination by End User:
You may terminate this Agreement at any time by discontinuing the use of the Software and notifying McTrans. No
refunds will be provided for any remaining portion of the Subscription Term.

13. GOVERNING LAW:

This License Agreement shall be governed by the laws of the State of Florida, U.S.A. Venue for all disputes related
to this License Agreement shall be in the United States District Court of the Northern District of Florida, Gainesville
Division, or in the Circuit Court of the Eighth Judicial Circuit for Alachua County, Florida.

14. U.S. GOVERNMENT RESTRICTED RIGHTS:

The Software and associated documentation are provided with RESTRICTED RIGHTS. Use, duplication, or
disclosure by the U.S. Government is subject to restrictions as set forth in subdivision (c)(1)(ii) of The Rights in
Technical Data and Computer Software clause at 52.227-7013 or subparagraphs (c)(1) and (2) of the Commercial
Computer Software - Restricted Rights at 48CFR52.227-19. The contractor is McTrans, University of Florida, PO
Box 116585, Gainesville, FL 32611-6585.

15. EXPORT REGULATION:

The Software may be subject to U.S. export control laws and regulations, including the U.S. Export Control Reform
Act and its associated regulations. End User will not directly or indirectly export, re-export, transfer, or release the
Software to, or make the Software accessible from, any country, jurisdiction, or person to which export, re-export,
transfer, or release is prohibited by applicable U.S. laws and regulations. End User will comply with all applicable
laws and regulations and complete all required undertakings (including obtaining any necessary export license or
other governmental approval) prior to exporting, re-exporting, transferring, or releasing, or otherwise making the
Software available, outside the U.S. End User shall not export, re-export, transfer, or release the software or
software source code to any country which is comprehensively sanctioned by the U.S. Department of the Treasury,
Office of Foreign Assets Control (OFAC), as updated from time to time, which currently includes: Cuba, Iran, North
Korea, Syria, and the Donetsk, Luhansk, and Crimea regions of Ukraine.

16. SEVERABILITY:

If any portion of this License Agreement shall be declared void or a nullity by a court of competent jurisdiction, then
the remainder shall survive and remain in full force. Should you have any questions concerning this license, you
may contact the McTrans Center, University of Florida, PO Box 116585, Gainesville, FL 32611-6585, U.S.A., [1]
(800) 226-1013.
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Getting Started

System Requirements

HCS is designed for standard Windows installations. For optimal performance, the system should be Windows 10
or newer. While HCS may be compatible with older versions of Windows, any installation and operational issues
arising from using these older versions will be the sole responsibility of the end user.

Getting Started

Urban Street Reliability Analysis

Urban Street Reliability analyses evaluate the travel time reliability experienced by motorists on an urban street
facility. Travel time reliability reflects the distribution of trip travel time over an extended period of time. The
distribution arises from the occurrence of a number of factors that influence travel time (e.g., weather events,
incidents, work zone presence, etc.) The distribution describes how often these factors occur and how bad
operations are as a result. The methodology of the application uses the HCM Chapter 17 procedure.
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General Controls

Menu Items

New — Creates a new Streets Reliability file (*.xsr) and starts a new analysis project; shortcut is Ctrl+N
Open — Opens an existing Streets Reliability file (*.xsr); shortcut is Ctrl+O
Example Folder — Opens folder with all HCS examples in File Explorer
Save — Saves an opened Streets Reliability file (*.xsr) using the current file name; shortcut is Ctrl+S
Save As... — Saves an opened Streets Reliability file (*.xsr) using a specified file name; shortcut is F12
Close — Closes an existing Streets Reliability file (*.xsr); shortcut is Ctrl+W
Units
USC Units — Changes the units of the current file to U.S. Customary
Metric Units — Changes the units of the current file to Metric
Print — Bring up printer selection and prints a USR report to the printer or specified file type; shortcut is Ctrl+P
Print Preview — Displays preview of current report before printing; shortcut is Ctri+F2
Report
Formatted Report — Displays formatted report including the most important values; shortcut is F4

Text Report — Displays text report with all input, intermediary, and final results; shortcut is F6

Default Settings — Opens a dialog box for user to input defaults for Analyst, Agency, and Jurisdiction, which will
be applied to all new files; also allows selection of USC or Sl units, which will be applied to all new files; shortcut if
Alt+F

Help

Contents — Provides access to glossary, acknowledgements, copyrights, and information on the Chapter
HCM procedure; shortcut is Ctrl+F1

Index — Allows user to search for keywords within the glossary

Search — Allows user to search for keywords within the Contents

User Guide — Opens a comprehensive user guide in PDF format; shortcut is CtrlI+G
HCM Reference Guide — Opens a reference guide for the HCM in PDF format

HCS Updates — Sends the HCS version number anonymously without any personally identifiable
information to McTrans to check for a newer version

HCM/HCS Training - Opens the McTrans Training Page in the default web browser to view the latest
training opportunities

HCQS Web Page — Opens the TRB Highway Capacity and Quality of Service Committee page in the default
web browser

Support
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Frequently Asked Questions — Opens the McTrans support page for HCS in the default web
browser

HCS Overview — Opens the McTrans HCS Overview page in the default web browser
McTrans Website — Opens the McTrans home page in the default web browser

E-mail McTrans — Composes a new e-mail addressed to McTrans in the default e-mail client with
registration number, serial key, module, and version number already populated in the Subject field

About HCS - Opens an about window with software version information, EULA, general
acknowledgements, contact information, and other relevant links

Exit — Exits the HCS Streets Reliability module; shortcut is Ali+F4
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Urban Streets Reliability

HCM Chapter 17

The Highway Capacity Software (HCS) faithfully implements the methodology prescribed in the Highway Capacity
Manual (HCM) for analyzing travel time reliability on an urban street. This chapter's methodology relies on
methodologies in other HCM chapters to compute the desired performance measures. Specifically, the
methodology for aggregating segment performance measures to obtain an estimate of facility performance is
described in Chapter 16. The methodology for evaluating the individual segments is described in Chapter 18. The
methodologies in Chapters 16 and 18 are applicable to an urban street facility that typically has a length of 1 mi (or
1.6 km in metric) or more in downtown areas and 2 mi (or 3.2 km in metric) or more in other areas.

At its core, the reliability methodology consists of hundreds of repetitions of the urban street facility methodology
presented in Chapter 16. In contrast to the Chapter 16 methodology, where the inputs represent average values for
a defined analysis period, the reliability caries the demand, capacity, geometry, and traffic control inputs to the
facility methodology with each repetition (i.e., scenario).

The reliability methodology can be used to evaluate the following sources of unreliable travel time:

e Demand fluctuations,

e Weather,

e Traffic incidents,

e Work zones,

e Special events,

¢ Inadequate base capacity, and

e Traffic control devices on urban streets.

Demand fluctuations are represented in the methodology in terms of systematic and random demand variation by
hour of day, day of week, and month of year. Fluctuations due to diversion are not addressed directly by the
methodology but can be optionally provided by the analyst for work zones and special events through the demand
specified in an alternative dataset.

LIMITATIONS OF THE METHODOLOGY

Because the reliability methodology is based on applying the urban streets methodologies multiple times, they
inherit the limitations of those methodology, as described in Chapters 16, 18, and 19, respectively. The reliability
methodology has additional limitations as described in the following paragraphs.

In general, the urban street reliability methodology can be used to evaluate the performance of most urban street
facilities. However, the methodology does not address the events or conditions in the following list:

Truck pickup and delivery (double parking);

Signal malfunction;

Railroad crossing;

Railroad and emergency vehicle preemption;
Signal plan transition; and

Fog, dust storms, smoke, high winds, or sun glare.
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Lane or shoulder blockage due to truck pickup-and-delivery activities in downtown urban areas can be considered
incident-like in terms of the randomness of their occurrence and the temporal extent of the event. The dwell time
for these activities can range from 10 to 20 min.

A signal malfunction occurs when one or more elements of the signal system are not operating in the intended
manner. These elements include vehicles detectors, signal heads, and controller hardware. A failure of one or more
of these elements typically results in poor facility operation.

A railroad crossing the facility at a midsegment location effectively blocks traffic flow while the train is present. Train
crossing time can be lengthy (i.e., typically 5 to 10 min) and can result in considerable congestion extending for one
or more subsequent analysis periods.

Railroad preemption occurs when a train crosses a cross-street leg of a signalized intersection. The signal operation
is disrupted for several cycles after train clearance.

When a new timing plan is invoked, the controller goes through a transition from the previous plan to the new plan.
The transition period can last several cycles, during which traffic progression is significantly disrupted.

Some weather conditions that restrict driver visibility or degrade vehicle stability are not addressed by the
methodology. These conditions include fog, dust storms, smoke, and high winds.

Operational Data

Base Dataset

On the Base Dataset page, the user is required to load a base file to run an Urban Streets Reliability analysis. There
are two options when using a base file: Select Base File and Create Base File. The program requires the HCS
Streets module for both these options. The Select Base File button opens a dialog that allows users to open an
existing HCS Streets (*.xus) files. The Create Base File button launches the Streets module where a user can
create a new HCS Streets dataset. If HCS is already installed on the computer, then the Streets module should
open when this button is clicked. If HCS is not installed, an error will popup and HCS will need to be installed on
the computer to continue with the Urban Streets Reliability analysis.

The Base Dataset page shows a summary of the data from the Streets file. When a Streets file is loaded, the
required information from the dataset is extracted for reliability analysis. Two sections appear when the Streets file
is loaded: Street intersections and segments graph and Street general information. The number of intersections
and segments, along with the distance between the intersections and the posted speed limit are displayed
graphically in the first section. The second section lists out the Street Name, Analysis Name, Analysis Year, Analysis
Date, Start Time, Period Duration, number of periods, File Name, and any comments taken directly from the Streets
file.

Analysis

The Analysis page is used to specify the duration of the reliability reporting period. There are three main sections
in the analysis page: Reporting Period, Study Period, and Analysis Summary.

The reliability reporting period represents the specific days over which the travel time distribution is to be computed,
for example, all nonholiday weekdays in a year. The period is specified by start and end dates as well as by the
days of week being considered. The start and end dates can be selected by clicking the calendar in the respective
textbox and selecting the date on the calendar or by typing the date in the format MM/DD/YYYY. The days of week
to be considered in a reliability analysis can be selected by clicking the checkboxes provided for each day of the
week.

If these values are not changed by the user, the following defaults will be used:

e Start Date: 1/1/2011
e End Date: 1/1/2012
o Days of Week: Mon, Tue, Wed, Thu, Fri (all weekdays)
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The number of days should be reflected under each month based on the information input for reporting period. The
reliability reporting period is used with the study period to describe the temporal representation of the performance
measure fully (e.g., average travel time on nonholiday weekdays from 4:00 to 6:00 p.m. for the current year).

The study period is the time interval (within a day) that is represented by the performance evalutation. It consists of
one or more consecutive analysis periods. The default analysis Start Time is taken from the base dataset and can
be edited if needed. The End Time is calculated based on the Start Time, number of periods, and duration of Period
from the base dataset. End Time and Duration cannot be edited in the Streets Reliability program, but can instead
be changed in the base dataset through Streets.

The analysis summary includes: Total number of analysis days, Number of scenarios per day, Number of standard
scenarios, and Total Number of scenarios. The Number of standard scenarios is the Total number of analysis days
multiplied by the Number of scenarios per day. The Total Number of scenarios is the number of standard scenarios
and alternate scenarios (if any).

Weather

A main source of variability that leads to travel time unreliability is weather. Weather events can affect capacity and
possibly demand. The Reliability methodology provides default values for use by location.

On the weather page, a drop-down list is located at the top left of the screen where a city with available weather
data can be chosen. A city can also be typed into the search bar, which will then match and select the city from the
drop down list.

Once a city is selected, Load Regional Weather needs to be selected for the weather data to be reflected in the
page. This button automatically imports historical weather data for the selected city from a local database file that
is distributed with the program. The fields in the table can edited if necessary. If a mistake is made and the user
wants to revert back to the previous values, then the Reset to Regional Default can be selected to discard recent
changes and restore default values for the selected city.

Under the Weather Data table are also weather factors affecting demand. These include: Pavement runoff duration
for snow event (h), Demand change factor for dry weather, Demand change factor for rain event, and Demand
change factor for snow event. The defaults for these are 0.5 hours, 1.0, 1.0, and 0.8, respectively. The user has the
option of changing these values if necessary. The duration of pavement runoff for a snow event is required. An
appropriate local value should be established for the subject facility if possible.

Demand

Another main source of variability that leads to travel time unreliability is the temporal variability in traffic demand—
both regular variations by hour of the day, day of the week, and month or season of the year and random variations
between hours and days. The Demand page is used to display user inputs related to demand and to specify demand
factors.

One of the required inputs is the Urban Street Funtional Class. There are three urban street functional classes
considered: Expressway, Principal Arterial, and Minor Arterial. The default in the program is Expressway. Once
selected, the defaults for Hours of the Day Ratios, Days of the Week Ratios, and Months of the Years Ratios are
displayed. Similar to the table on the Weather page, the fields in these tables can be edited if necessary. The Base
Dataset Traffic Count Date is automatically set to the date found in the Streets base file, but can also be changed
if necessary. Similar to the Analysis page, the date can be selected by clicking the calendar in the textbox and
selecting the date on the calendar or by typing the date in the format MM/DD/YYYY. Depending on the date
selected, the Base Demand Ratio is calculated using Hours of the Day Ratios, Days of the Week Ratios, and Months
of the Year Ratios.
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Incident

Another main source of variability that leads to travel time unreliability are incidents that block travel lanes or
otherwise affect traffic operations and thus capacity. The Incident page is used to specify user inputs related to
incidents, their frequencies, reponse time, clearance time, and distributions. There are three tabs within the Incident
page: General, Clearance Time, and Distribution.

The General tab displays the crash frequency adjustment factors for different weather types, the incident response
time in minutes for different weather types, the incident detection time in minutes, shoulder presence, and the
average crashes per year for both segments and intersections. All these fields are pre-populated with the default
values provided in Chapter 17. The shoulder presence checkbox is used to switch the different input tables for
incident distirbutions. If the checkbox is checked, the input table under the Distribution tab will include Shoulder in
the Incident Location - Affected column. If the checkbox is unchecked, the input table will only display One Lane
and 2+ Lanes under the Incident Location - Affected column. Rows form under “Average Crashes per Year”
depending on the number of Segments and the number of Intersections coded in the Streets Base File loaded for
analysis. Segments will display before Intersections.

The Clearance Time tab displays a table with the incident clearance time in minutes for different incident types,
which are based on Street Location, Event Type, Lane Location, Severity, and Weather Type. Street Location
includes Segment and Intersection. Event Type includes Crash or Non-Crash. Lane Location includes One Lane,
2+ Lanes, or Shoulder. Severity types include fatality/injury (F/) and property-damage-only (PDO) if the Event Type
is Crash, and Breakdown and Other if the Event Type is Non-crash. Weather Types include Dry, Rainfall, Wet
Pavement, and Snow or Ice.

The Distribution tab displays a table with the incident proportions based on Street Location, Incident Type, Incident
Location, and Incident Severity.

Scenarios
The Scenarios page displays two sections: Scenario Generation Settings and Progress Status.

The checkboxes in the Scenario Generation Settings indicate whether or not the user wants to include the
corresponding variability in the reliability analysis. The three variables include: Weather, Demand, and Incident. If
a checkbox is unchecked, then the variable is not considered in the analysis. For example, if the Incident checkbox
is unchecked, then incident scenarios will not be generated. Unique seed numbers are separately established for
weather events, demand variation, and incidents. A seed is used so that the sequence of random events can be
reproduced. For a given set of three seed numbers, a unique combination of weather events, demand levels, and
incidents is estimated for each analysis period in the reliability reporting period. The user can also specify to
randomize demand volume for every analysis period by checking the checkbox. This checkbox is automatically
checked for an Urban Streets Reliability File (*.xsr).

Progress Status displays the Replication number currently generating, the Scenarios Generated out of the total
number of scenarios, and the time elapsed in seconds for generating scenarios. If the user chooses to stop
generating scenarios, a Cancel button is located below Time Elapsed.

Once all scenarios are generated, “Scenario Generation Completed.” will display after Scenarios Generated. The
user may select Save or Close from the menu if saving the scenarios generated is needed. If the user selects Save,
a pop-up will appear asking if the user wants to save the scenarios generated. If the user selects Close, a pop-up
will appear asking if the user wants to save the reliability analysis. Then, a second pop-up will appear asking if the
user wants to save the scenarios generated. If the user chooses to save the scenarios generated, then each of the
Streets files will be saved to a folder, based on the replication (R1, R2, R3, etc.), where the Streets Reliability (*.xsr)
file is saved.

Events

Once all scenarios are generated, the Events page will display event predictions. There are four tabs for the Event
Predictions: Summary, Weather, Demand, and Incident. Tabs will be populated depending on which types of
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scenarios were included under the Scenario Generation Settings. If the number of replications specified by the user
was greater than 1, the drop-down list next to Replication can be used to switch between replications.

Under Summary, the user can specify how many scenarios per page to display by selecting a number from the
drop-down list in the upper left hand corner of the section. Since all scenarios cannot be displayed on the page,
navigation buttons (<< First, < Previous, Next >, and Last >>) can be found at the bottom of the screen. The current
page out of the total number of pages is also displayed at the bottom of the screen. On each Summary page, a
table will be displayed with the Analysis Period, Weather Event, Precipitation Rate, Demand Factor, Incident
Occurrence, and Incident Count.

Under Weather, the user can specify how many Weather details per page are displayed by selecting a number from
the drop-down list in the upper left hand corner of the section. Since all scenarios cannot be displayed on the page,
navigation buttons (<< First, < Previous, Next >, and Last >>) can be found at the bottom of the screen. The current
page out of the total number of pages is also displayed at the bottom of the screen. On each Weather page, a table
will be displayed with the Date, Precipitaion RN, Precipitation (Yes/No), Temperature RN, Temperature (F),
Snow/Rain, Precipitation Rate RN, Precipitation Rate (in./h), Total Precipitation RN, Total Precipitation (in.),
Precipitation Start RN, Precipitation Start Time, Precipitation Duration (h), Time Wet After Precipitation (h),
Day/Night?, Total Event Duration (h), End of Precipitation, and Wet Pavement End. A horizontal scroll bar is placed
under the table to view all columns.

Under Demand, the user can specify how many Demand details per page are displayed by selecting a number from
the drop-down list in the upper left hand corner of the section. Since all scenarios cannot be displayed on the page,
navigation buttons (<< First, < Previous, Next >, and Last >>) can be found at the bottom of the screen. The current
page out of the total number of pages is also displayed at the bottom of the screen. On each Demand page, a table
will be displayed with the Analysis Period, Weather, Weather Factor, Hour Factor, Day Factor, Month Factor, Total
Factor, and Total/Base. A horizontal sroll bar is placed under the table to view all columns.

Under Incident, there are two other tabs: Crash Frequency and Other. For each of the segments and intersections
coded in the base dataset, the Crash Frequency tab displays the Observed Average Crash Frequency, Number of
Years, Hours of Dry Weather, Hours of Rainfall, Hours of Wet Pavement, Hours of Snowfall, Hours of Snow
Pavement, Crash Frequency Adjustment Factor for Rainfall, Crash Frequency Adjustment Factor for Wet
Pavement, Crash Frequency Adjustment Factor for Snowfall, Crash Frequency Adjustment Factor for Snow
Pavement, Crash Frequency for Dry Weather, Crash Frequency for Rainfall, Crash Frequency for Wet Pavement,
Crash Frequency for Snowfall, and Crash Frequency for Snow Pavement.

The Other tab displays a Parameters section in which a user can set a date, a time, and a segment or intersection
to gather information on incidents. Similar to the Analysis page and Demand page, the date can be selected by
clicking the calendar in the textbox and selecting the date on the calendar or by typing the date in the format
MM/DD/YYYY. A drop-down list with different hours of the day can be used to select a time and a drop-down list
with the different segments and intersections can be used to select which segment or intersection is needed for
information. Below these drop-downs is a Query button, which the user can click to check for incidents starting at
the selected query hour. Once clicked, tables will appear for three subtabs: Determination, Duration, and Location.

The Determination tab displays Proportion, Frequency per Hour, exp (-fi x pi), Random Number, and Incident? for
different types of incidents.

The Duration tab displays values for the following variables: Location, Incident type, Number of lanes involved,
Incident severity, Weather, Incident detection time (min), Incident response time, dry weather (min), Incident
clearance time (min), Average incident duration (min), Standard deviation of incident duration (min), Average
incident duration (h), Standard deviation of incident duration (h), Random number, Gamma function alpha
parameter (mean?/variance), Gamma function beta parameter (mean/variance), Duration (h), Rounded duration
(nearest 15 min) (h), Incident start time, and Incident end time.

The Location tab displays values for the following variables: Incident number; Incident type, location and severity;
Random number; Location index; Location; and Directional probabilities for EB, WB, NB, and SB.
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Summary

Once all scenarios are generated, the Summary page will display Scenario Details. If the number of replications
specified by the user was greater than 1, the drop-down list next to Replication can be used to switch between
replications. In the Scenario Details, the following are displayed for each scenario: Scenario ID, Analysis Period,
Travel Time FWD (s), Travel Time REV (s), Travel Speed FWD (mi/h), Travel Speed REV (mi/h), and Facility Delay
(veh-h). Hovering over each Scenario ID will show the path for the file location.

Urban Streets Reliability Report

The Report page displays the results of the analysis in the form of tables and graphs. There are two reports available
to the user: the formatted report and the text report. The formatted report is initially displayed, but the user can
switch to the text report by clicking the Switch to Text Report button located at the top of the screen. Similarly, if the
user has the text report displayed, the Switch to Formatted Report button located at the top of screen can be used
to display the formatted report instead.

The formatted report provides an overview of the results in a table. There are four sections in the table: Base
Dataset Analysis, Realiability Input Summary, Reliability Performance Measure Results, and Travel Time results
for each replication. Base Dataset Analysis provides general information that can be found in the base dataset.
Reliability Input Summary provides general information on the reliability analysis and the random seed summary.
The random seed numbers displayed on this report are for the first replication. Random seed numbers for each
replication can be found in the text report. Reliability Performance Measure Results provides information on the
following performance measures for each major street direction: Vehicle miles traveled (veh-m), Number of
Scenarios, Base free-flow travel time (s), Mean TTI, 80™ percentile TTI, 95" percentile TTI (PTI), Reliability rating
(%), and Total delay (veh-h). The last section of the table includes information on travel time for each replication.
The average travel time and the 95" percentile travel time is provided in the formatted report, but more information
can be found in the text report. Below the table are two graphs displaying the Travel Time Frequency Distribution
for both the Major Street Forward and Reverse directions.

The text report provides more detailed results. The results for the major street forward direction are displayed first
and then the results for the other major street reverse direction is displayed. The following performance measures
are displayed for each major street direction: Vehicle Miles Traveled (veh-mi), Base Free-Flow Speed (mi/h), Base
Free-Flow Travel Time (s), Reliability Rating, and Number of Scenarios. Following this is information for each
replication. Each replication displays the Random Number Seeds for Weather, Demand, and Incident. Then the
Average, Standard Devaition, Skewness, Median, 51" Percentile, 10" Percentile, 80" Percentile, 851" Percentile,
and 95" Percentile are displayed for Travel Time (s), Travel Speed (mi/h), Stop Rate (stops/veh), Running Time
(s), Through Delay (s/veh), and Total Delay (veh-hr).
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How To

Create a New File

From the Start screen, there are three options for creating a new file:

1.

Recent

STREETS RELIABILITY E-mail McTrans

¥4 HCS2025

Copyright © 2024 University of Florida. All Rights Reserved. HCS™ Streets Reliability Version 2025

Note: A new file can be created if an existing file is already open; you do not need to start from the Start
screen.
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a. Selecting File > New from the main menu; this can be found by selecting the three lines in the top
left-hand corner of the screen and then selecting “New”
== HCS Streets Reliability

New
Open Ctrl+0

Example Folder

Save Help

Save As

3

Close

Units > T  — H_CS_UD_d.alﬂS

Print Preview McTrans Website
Report » HEMLHCS_'D:ammg
Default Settings _ AltaF STREETS RELIABILITY E-mail McTrans
Help » A t HCS

Exit Alt+F4

¥  HCS2025

Copyright © 2024 University of Florida. All Rights Reserved HCS™ Streets Reliability Version 2025

b. Selecting “New File...” from the Start screen; this can be found below in the red box

ar HCS Streets Reliability

Recent

STREETS RELIABILITY E-mail McTrans

¥4 HCS2025

Copyright © 2024 University of Florida. All Rights Reserved. HCS™ Streets Reliability Version 2025

c. Using keyboard shortcut “Ctrl+N”
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2. Once a new file is created, you will be brought to the Base page

-

-
—
—_—
—

START BASE ANALYSIS WEATHER DEMAND INCIDENT SCENARIOS EVENTS SUMMARY REPORT

Select Base File Create Base File

© ©,

Back Next

Copyright © 2024 University of Florida. All Rights Reserved. HCS™ Streets Reliability Version 2025 (USC)

Open an Existing File

1.

From the Start screen, there are six options for opening an existing file:

STREETS RELIABILITY

¥ HCS2025

Copyright © 2024 University of Florida. All Rights Reserved. HCS™ Streets Reliability Version 2025

Note: A file can be opened even if another file is currently open; you do not need to start from the Start
screen.
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a. Selecting File > Open from the main menu; this can be found by selecting the three lines in the top
left-hand corner of the screen and then selecting “Open”
== HCS Streets Reliability

New

Open Ctrl+O
Example Folder

Save He'p

Save As X
oy Topics

Close W

Units > L = H'CS_U'M

Print HCS Overview

Print Preview McTrans Website

Repor s HCM/HCS Training

Default Settings _ Alt+F STREETS RELIABILITY E-mail McTrans

Help > About HCS

Exit

¥4 HCS2025

Copyright © 2024 University of Florida. All Rights Reserved. HCS™ Streets Reliability Version 2025

b. Selecting “Open File...” from the Start screen; this can be found below in the red box

= HCS Streets Reliahility ==

Recent

STREETS RELIABILITY E-mail McTrans

¥4 HCS2025

HCS™ Streets Reliability Version 2025

Copyright © 2024 University of Florida. All Rights Reserved.

c. Using the keyboard shortcut “Ctrl+O”
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d.

Selecting a file under the Recent files list from the Start screen; this can be found below in the red
box

Help
amBa s
—_— P HCS Updates
- s
McTrans Website
S i
E-mail McTrang
About HCS

STREETS RELIABILITY

e. Selecting File > Example Folder from the main menu; this can be found by selecting the three lines
in the top left-hand corner of the screen and then selecting “Example Folder”. Opening the example
folder will open the path of the HCS example files in File Explorer. The desired example file can be
double-clicked or right-clicked and selecting ‘Open’, which will open the example file in the Streets
Reliability program.

== HCS Streets Reliability
New
Open
Example Folder
?avc ’ Help
:] ‘:’ L'V‘v"“ S H I .
Umrts _— m&dﬁlﬁi
Print HCS Overview
Print Preview McTrans Website
Report » H_CM[HCS_ILQIDLDQ
Defouit Settings_ Altet STREETS RELIABILITY E-mail McTrans
Help » About HCS
Exit Alt+F4
Y HCS2025
Copyright © 2024 University of Florida. All Rights Reserved. HCS™ Streets Reliability Version 2025

f. Selecting “Example Folder...” from the Start screen; this can be found below in the red box.
Opening the example folder will open the path of the HCS example files in File Explorer. The
desired example file can be double-clicked or right-clicked and selecting ‘Open’, which will open
the example file in the Streets Reliability program.
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R

eliability

Recent

STREETS RELIABILITY E-mail McTrans

Y4 HCS2025

Copyright © 2024 University of Florida. All Rights Reserved. HCS™ Streets Reliability Version 2025

2. Once an existing file is opened, you will be brought to the Base page

= START BASE ANALYSIS WEATHER DEMAND INCIDENT SCENARIOS EVENTS SUMMARY REPORT
Select Base File Create Base File

Street intersections and segments graph

1800 ft
35 mph

Street general information

Street Analyst

@ Analysis Year Analysis Date  1/4/2011 12:00:00 AM
Start Ti 700 Period Duration 15 Minut
art Time riod Duration inutes =
Periods 1 File Name StreetsBase1.xus
Comment

Copyright © 2024 University of Florida. Al Rights Reserved. HCS™ Streets Reliability Version 2025 (USC)
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Save a File

1. There are five options for saving an open file:

a. Selecting File > Save from the main menu; this can be found by selecting the three lines in the top
left-hand corner of the screen and then selecting “Save”

5 SuectsRelibiltyLusr * - HCS Sreets Refobilty - 6 X

= START BASE ANALYSIS WEATHER DEMAND INCIDENT SCENARIOS EVENTS SUMMARY REPORT

New
Open - .
Example Folder Select Base File Create Base File
Save Curl+s
Save s Street intersections and segments graph
Close
Units >
print t
Print Preview 1800 ft
K 35 mph

Rep

Default Settings

Help
Bxit
Street general information

Street Analyst
Analysis Year 2024 Analysis Date  9/17/2024 120000 AM

=~ StartTime 700  Period Duration 15 Minutes et

e

Periods 1 File Name Streets1-MotorizedVehiclexus
Comment  Chapter 30: Example Problem 1

HCS™ Streets Reliability Versi

Copyright © 2024 f Florida. All Rights Reserved

b. Selecting File > Save As... from the main menu; this can be found by selecting the three lines in
the top left-hand corner of the screen and then selecting “Save As...”

= StretsRelisiity e - HCS Sreets Relabily

= START BASE ANALYSIS WEATHER DEMAND INCIDENT SCENARIOS EVENTS SUMMARY REPORT

New

Open

Base File

Example Folder
Save

Save As il Street intersections and segments graph
Close

Units

Print

1800 ft
35 mph

Street general information

Street Analyst

@ Anlysic Vear 2024 Analysis Date  S/17/2024 120000 AM
StartTime 700  Period Duration 15 Minutes
Back Next
periods 1 File Name Streets1-MotorizedVehiclexus
Comment  Chapter 30: Example Problem 1

HCS™ Streets Reliability Version 2025 (USC)

sty of Florida. All Rights Reserved.

c. Using the keyboard shortcut “Ctrl+S” for Save
d. Using the keyboard shortcut “F12” for Save As
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e. Exiting the program or closing the file without saving changes beforehand; this will prompt you to
save the current reliability analysis before anything is closed

HCS Streets Reliability X

Do you want to save current reliability analysis?

Yes No Cancel

i. Selecting “Yes” will save the file if it is an existing file. If the file has not been previously
saved, the Save As dialog box will pop up allowing you to change the file name and save
it.

ii. Selecting “No” will exit the program or close the file without saving the file
iii. Selecting “Cancel” will prevent the file from closing

iv. If you have generated scenarios and then decide to exit the program or close the file, you
will receive two prompts: the aforementioned prompt and a Save Scenarios prompt

Save Scenarios

Do you want to save generated Reliability Scenarios?

Yes No

1. Selecting “Yes” will save all the scenario files generated and create folders based
on the number of replications

2. Selecting “No” will exit the program or close the file without saving the scenario
files generated

Note: Using Save with an existing file will save a file without prompting you to specify a file name. Using Save with
a new file will bring up the Save As dialog box for you to specify a file name for saving. Using Save As will always
bring up the Save As dialog box for you to specify a file name for saving.
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Close a File
1. There are three options for closing an open file:

a. Selecting File > Close from the main menu; this can be found by selecting the three lines in the top
left-hand corner of the screen and then selecting “Close”

= SueetsRelbily - HCS Stees Refsilty - 8 x

= START BASE ANALYSIS WEATHER DEMAND INCIDENT SCENARIOS EVENTS SUMMARY REPORT

elect Base File

e s Street intersections and segments graph

Close

Units

print

Print Preview t ( ) 1800 ft ( )
oon 5 35 mph

Default Setting: t

Street general information

Street Analyst

@ Analysis ear 2024 Analyss Date  9/17/2024 120000 AM
StartTime 700  Period Duration 15 Minutes
Back Next
Periods 1 File Name Streets1-MotorizedVehicle xus

Comment  Chapter 30: Example Problem 1

Copyright © 2024 Uriversity of Forida. All Rights Reserved HCS™ Streets Reliability Version 2025 (USC)

b. Using the keyboard shortcut “Ctrl+W”

c. Exiting the program itself; please see How To: Exit the Program

Exit the Program

1. From the Start screen, there are three options for exiting the program:

Recent

STREETS RELIABILITY E-mail McTrans

¥4 HCS2025

HCS™ Streets Reliability Version 2025

Copyright © 2024 University of Florida. All Rights Reserved.

Note: The program can be exited even if a file is still open; you do not need to start from the Start screen.

24 - How To Streets Reliability User Guide



a. Selecting File > Exit from the main menu; this can be found by selecting the three lines in the top
left-hand corner of the screen and then selecting “Exit”
== HCS Streets Reliability

New
Open Ctrl+0

Example Folder

Save Help

Save As

3

Close

Units > T  — H_CS_UD_d.alﬂS

Print Preview McTrans Website
Report » HEMLHCS_'D:ammg
Default Settings _ AltaF STREETS RELIABILITY E-mail McTrans
Help » A t HCS

Exit Alt+F4

¥  HCS2025

Copyright © 2024 University of Florida. All Rights Reserved HCS™ Streets Reliability Version 2025

b. Using the keyboard shortcut “Alt+F4”

c. Selecting “X” in the top right-hand corner of the screen; this can be found below in the red box

HCS Streets Reliability

Recent

STREETS RELIABILITY E-mail McTrans

¥ HCS2025

Copyright © 2024 University of Florida. All Rights Reserved. HCS™ Streets Reliability Version 2025
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Edit the Default Settings

1.

From the Start screen, there are two options for editing the Default Settings:

Recent

STREETS RELIABILITY E-mail McTrans

¥a HCS2025

Copyright © 2024 University of Florida. All Rights Reserved. HCS™ Streets Reliability Version 2025

Note: The Default Settings can be changed even if an existing file is already open; you do not need to start
from the Start screen.

a. Selecting File > Default Settings from the main menu; this can be found by selecting the three lines
in the top left-hand corner of the screen and then selecting “Default Settings”

= HCS Streets Reliability

New
Open

Example Folder

Save Help

Save As

Close

;

i = — HCS Updates

o HCS Overview
Report > HCM/HCS Training
DefaultSettings __ AItoF STREETS RELIABILITY E-mail 46 Tans
Help » About HCS

Exit Alt+F4

¥ HCS2025

Copyright © 2024 University of Florida. All Rights Reserved. HCS™ Streets Reliability Version 2025

b. Using the keyboard shortcut “Alt+F”
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Opening the Default Settings will cause a Default Settings window to pop up:

: Default Settings X

Analyst
Agency
Jurisdiction
New File Default Units
® USC U Metric

OK Cancel

You can Specify Analyst, Agency, and Jurisdiction by clicking the corresponding text boxes and typing the
desired text.

Under ‘Units’, you are given the option of running the analysis in either U.S. Customary (USC) or S/ (Metric)
units.

Clicking “OK” will save the changes made and close the Default Settings window; clicking “Cancel” will
close the Default Settings window without saving any changes.

When a new file is created, the Analyst, Agency, and Jurisdiction fields will automatically be populated with
the text specified in the Default Settings.

When starting a new file, the input and results will display according to the units specified in the Default
Settings.

Load a Base File

1. On the Base page, there are two options to load a base file: ‘Select Base File’ and ‘Create Base File’

= START BASE ANALYSIS WEATHER DEMAND INCIDENT SCENARIOS EVENTS SUMMARY REPORT

Copyright © 2024 University of Florida. All Rights Reserved. HCS™ Streets Relability Version 2025 (USC)
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a. ‘Select Base File’ will bring up an Open dialog box to allow selection of an existing Streets (*.xus)
file

START BASE ANALYSIS WEATHER DEMAND INCIDENT SCENARIOS EVENTS SUMMARY REPORT

Select Base File Create Base File

Copyright © 2024 University of Florida. All Rights Reserved.

HCS™ Streets Reliability Version 2025 (USC)

« v oA > ThsPC » OS(C) » Program Fles (86) » Mclians » HCS2024 > Bromple c »
Organize = New folder = o e
Hes . ) e Base File
s Altemative Inersections
TSIS-CORSIM # ek
HoM * Sueets Relabiity
s # W interchonges-Diamondus

1 interchanges2-ParcloA2Q.xus
1l iterchanges3-DiamondWithQueueSpillack xus

23 UFL Dropbox
B This PC
os(c)

| 1 interchangesd-DiamondWithDemandstarvation.
1 interchangess-DivergingDiamondWithSignaico.
| B interchanges7-SPULxs.

== Meltans Shared nges8 DiamondWithAdjacentintersecti

Flle name: HCS Streets Fils (*us)

Open Cancel

Next
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b. Create Base File’ opens the HCS Streets program allowing you to create a Streets (*.xus) file which
can then be saved and loaded into HCS Streets Reliability using the ‘Select Base File’ button

S StreetsRelabiltylxsr * - HCS Strets Refabity 5 X
= START ANALYSIS WEATHER DEMAND INCIDENT SCENARIOS EVENTS SUMMARY REPORT

1. Ploase solect 2 Base Dataset.

Select Base File [

S StrectsReliabilityl.xsr - HCS Streets Refiablty - a
= START ANALYSIS WEATHER DEMAND INCIDENT SCENARIOS EVENTS SUMMARY REPORT

1. Plsse seloct  Base Datosot.
1 Hcs Streets =
Fie View it Windows Hep
DRSO ™0 s @k e
HCS Streets Version 2025
Open

Select mode to create new dataset

[ classic mode |
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Load Regional Weather

On the Weather page, a weather location must be selected for an analysis if Weather is included in scenario
generation.

= START BASE ANALYSIS WEATHER DEMAND INCIDENT SCENARIOS EVENTS SUMMARY REPORT

£~ Load Regional Weather Reset to Regional Default

Current Location:

Jan | Feb [ Mar [ Apr | May | Jun | Jul | Aug | sep [ Oct [ Nov [ Dec

Total normal precipitation (in.) 00 | 00 [ 00 [ 00| 00|00 0o) oo oo oofoo]foo0

Total normal snowfall (in) 00 [ 00 [ 00 [ 00| 00| 00| oo oo oo oofoo]foo
Days with precipitation* 0 o | oo 0 o | o o lo oo 0

Average temperature (degreeF) | 00 | 00 | 00 | 00 | 00 | 00 | 00 [ 00 | 00 | 00 | 00 | 00

Precipitation rate (in) 00 | 00 [ 00 [ 00| 00| 00 0o oo oo oofoo]foo0

Pavement runoff duration for snow event (h) |~ 0.5

Demand change factor for dry weather 1

Demand change factor for rain event 1 |
Demand change factor for snow event 08 I

Back Next

Copyright © 2024 University of Florida. All Rights Reserved. HCS™ Streets Reliability Version 2025 (USCQ)

2. A drop down list of U.S. cities is provided. You can open the list by selecting the down arrow and scrolling
through to search for a particular city or you can type a city in the box which will find the location in the |ISt

Str«ulklmbnhlyl Jxsr* - HCS Streets Relability
= START BASE ANALYSIS WEATHER DEMAND INCIDENT SCENARIOS EVENTS SUMMARY REPORT

loct a Weat

28| Load Regional Weather Reset to Regional Default
ABERDEEN, SO -
ABILENE, TX o
AKRON,OH
Mar un | ul oct [ Nov [ Dec
ALAMOSA, CO 2P| ey, Aigll|isen
ALBANY, NY 00 00 00 00 00 00 00 00 00 00

ALBUQUERQUE. NM
ALLENTOWN, PA
ALPENA. MI 0 o [ 1] 0 ] ] 0 0 0
MO TX 00 | 00 [ 00 | 00 | 0o [ 00| 00| 000000
ANCHORAGE, AK

ANNETTE, AK 00 [ 00 | 00 [ 00 [ 00|00 o0]o00] o000
APALACHICOLA, FL

ASHEVILLE NC J
Paverent FURGH dUFation Tor Srow event (AT 05

Demand change factor for dry weather 1

00 | 00 | 00 | 00 [ 00 | 0o | 00| 00| 00| o0

Demand change factor for rain event 1

Demand change factor for snow event 08

Q)

Next

Copyright © 202 of Florida. All Rights Reserved. ets Reliability Version 2025 (U
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= StrestsRelisbiityLsr * - HCS Streets Reliabiity - @ X

= START BASE ANALYSIS WEATHER DEMAND INCIDENT SCENARIOS EVENTS SUMMARY REPORT

I GAESVILE T - I

Reset to Regional Default

Current Location:

Jan | Feb | Mar | Apr [ May | Jun | sl | dug | sep | oct | Nov | Dec

Total normal precipitation fin} 00 | 00 | 00 | 00 | oo | 0o | co|ao|o0|on|oo]foe
Total normal snowdall in) 00 | 00 | 0o | oo | oo | oo | oo oo | oo oo |oo] oo
Days with precipitation® 0 0 0 0 0 0 o 0 ] 0 0 o

Average temperature (degree) | 00 | 00 | 00 | 00 | 0o | oo | 0o | 0o | o0 | 00 | 00 | 0o
Precipitation rate (in) 00 | 00 | 0o [ oo | oo |oo]oo|oo|oo]oooo] oo

Pavement runoff duration for snow event (h) 05

Demand change factor for dry weather 1
k Demand ehange factor for rain event 1
Demand change fiactor for snow event 08

Back Next

sity of Florida. Al Rights Reserved.

3. Once a city is selected, click the ‘Load Regional Weather’ button. This will populate the table below with
information based on the location selected.

= Sueeuf

= START BASE ANALYSIS WEATHER DEMAND INCIDENT SCENARIOS EVENTS SUMMARY REPORT

GANESVILLE FL - Load Regianal Weather Reset to Regional Default

Current Location: GAINESVILLE. FL

Jan | Feb | Mar [ Apr | May | Jun | sl | Aug [ sep | Oct [ Nov | Dec

Total normal precipitation (in) 351 | 339 | 426 | 286 | 323 | 678 | 61 | 663 | 437 | 25 | 217 | 256
Total narmal snowfall (in) 0 0 oo o
Days with precipitation® ] 7 7 5 6 s |we|n T 6 6

Average temperature (degreeF) | 543 | 57 | 625 | 676 | 743 | 792 | 808 | 804 | 778 | 701 | 528 | 563

Precipitation rate (in) 0145 | 0116 | 0216 | 0.183 | 0.285 | 019 [ 0232 | 0206 | 0.193 | 0137 | 0:154 | 0106

Pavement runoff duration for snow event (h) 0.5

Demand change factor for dry weather 1
Demand change factor for rain event 1
@ Demand change factor for snow event 08 @
Back Next

4. This table is editable so individual cells can be changed if necessary.

5. If cells are changed, and you wish to reload the defaults of your chosen location, a ‘Reset to Regional
Default’ button is provided.
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Generate Scenarios

1. On the Scenarios page, Scenario Generations Settings are provided.

= START BASE ANALYSIS WEATHER DEMAND INCIDENT SCENARIOS EVENTS SUMMARY REPORT

(%) scenario Generation Settings

~ Progress Status

024 University of Florida, All Rights Reserved

2. Checkboxes are provided for Weather, Demand, and Incident to indicate whether or not to consider the
input provided on their respective pages in the scenario generation process.

= START BASE ANALYSIS WEATHER DEMAND INCIDENT SCENARIOS EVENTS SUMMARY REPORT

(=) Scenario Generation Settings

R e
include I & - -
Random seed” ) o =

W] Randomize Demand Vokame for every analysis peviod
Number of replications* 1

HO)
©
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3. Random Seed numbers are provided for Weather, Demand, and Incident so that a sequence of random
events can be reproduced.

= ®

= START BASE ANALYSIS WEATHER DEMAND INCIDENT SCENARIOS EVENTS SUMMARY REPORT

(<) scenario Generation Settings

Include ‘ & ‘ 7 | =
Random Seed® a2 " 63

! Randomize Demand Volume for svery analysis period

Number of replications® 1

¥ Progress Status

of Florida. All Rights Reserved.

4. A checkbox is also provided to give the option of randomizing demand volume for every analysis period.

= START BASE ANALYSIS WEATHER DEMAND INCIDENT SCENARIOS EVENTS SUMMARY REPORT

(%) Scenario Generation Settings

Include ‘ o ‘ = | =
Random Seed® 8 " 63

| rardomize Demand o for svery anaiyss pericd |

Number of replications® 1

¥ Progress Status

of Flarida. Al Rights Reserved
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5. The number of replications can be indicated before scenario generation. This is the number of times each
scenario is generated to minimize any bias that rare events may cause. For example, if there are 260
scenarios in an analysis and 2 replications, each replication will have 260 scenarios or a total of 520

scenarios. The default number of replications is 1.

= START BASE ANALYSIS WEATHER DEMAND INCIDENT SCENARIOS EVENTS SUMMARY REPORT

(=) scenario Generation Settings

Include | & | @ | =
Random Sesd” | 2 e PP

& Randomise Demand Volume for svery analysis period

INumb« of replications* 1 I

~ Pragress Status

Copytight © 2024 Uriversity of Florida. All Rights Reserved.

6. Once everything is set, click on the ‘Generate Scenarios’ button to start the scenario generation process.

= StrestiRetiabiity L - HCS Sivets Relsblty -

= START BASE ANALYSIS WEATHER DEMAND INCIDENT SCENARIOS EVENTS SUMMARY REPORT

(%) scenario Generation Settings

Includ ‘ & ‘ - | &
Ridom el 82 11 63

Demand Volume bor evey analysis penod

Number of replications* 1

Generate Scenarios

~ Progress Status

lorida. Al Rights Reserved.
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7. When scenario generation starts, the Progress Status section will indicate the current replication generating
scenarios, the current number of scenarios generated within the replication, and the time elapsed for
scenario generation. There is also a progress bar at the bottom of the window to indicate scenario
generation is in progress.

= StrestsReliability . sr - HCS Streets Relishility - a8 x

= START BASE ANALYSIS WEATHER DEMAND INCIDENT SCENARIOS EVENTS SUMMARY REPORT

io Generation Settings

(=) Progress Status
Replication : 1
Scenarios Generated : § out of 260 Scenarios
Time Elapsed : 0 hours 0 minutes 3 seconds

Cancel

8. When scenario generation is done, Scenarios Generated will say “Scenario Generation Completed.”

= START BASE ANALYSIS WEATHER DEMAND INCIDENT SCENARIOS EVENTS SUMMARY REPORT

[ scenario Generatian Settings

() Progress status

Replication: 1

[Scenarios Generated: Scenario Generation Completed ]
me Elapsed : 6 hours 1 minutes 34 seconds

Copyright © 2024 University of Flarida. All Rights Ressrved HCS™ Streets Raliability W
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9. The Events, Summary, and Report pages will be populated with results after completion of scenario
generation.

= START BASE ANALYSIS WEATHER DEMAND INCI T SCENARIOS EVENTS SUMMARY REPOR

Replcation |1 *
(=) Event Predictions
Summary Weather Incident
Scenarios per page: |20
I
i

1/4/2011 7:0000 AM Dry 0762 No

1/5/2011 7:00:00 AM Dry 0777 No

1/6/20117:0000 AM Ory 0801 No

1/7/2011 7:00:00 AM Ory 0894 No
1/10/2011 7:00:00 AM Dy 0762 No
1/11/2011 7:00:00 AM Dry 0.762 No
1/12/2011 7:00.00 AM. Dry 0777 No
1/13/2011 7:00:00 AM Ory 0801 No
1/14/2011 7:00:00 AM Dry 0894 No
1/17/2011 7:00:00 AM Dry 0.762 No
1/18/2011 7:00:00 AM Dry 0762 No
1/19/2011 7:00:00 AM Dry 0777 No

ik 1/20/2011 7:00:00 AM Ory 0801 No Nowt
1/21/2011 7:00.00 AM Dy 0894 No
1/24/2011 7:00.00 AM Dry 0762 No
1/25/2011 7:00.00 AM Dy 0762 No
1/26/2011 7:00:00 AM Dry 0777 No
1/27/20117:00:00 AM Dry 0801 No
1/28/2011 7:00:00 AM Dry 0834 No
First |< Previous Current Page: 1/13 | Next> | Last

Copyright © 2024 University of Florida. Al Right ™ Streets Reliabilty Version 2025 (USC)

= START BASE ANALYSIS WEATHER DEMAND INCIDENT SCENARIOS EVENTS SUMMARY REPORT

Replication |1 ~
|(® scenarios Details
S1 1/3/2011 7:00:00 AM 47.269 47.249 25.964 25974 10.094
2 1/4/20117:00:00 AM 47425 47411 25878 25886 10185
S3 1/5/2011 7:00:00 AM 47.154 47.165 26.027 26.021 10183
s4 1/6/20117:00:00 AM 48 47.988 25568 25575 10731
s5 1/7/20117:00:00 AM 49758 49785 24665 24651 12291
56 1/10/2011 7:0000 AM 47357 47355 25916 25917 10149
ST 1/11/2011 7:00:00 AM 46.995 46.992 26.115 26.117 10.003
58 1/12/2011 7:00:00 AM 47201 47198 26001 26002 10207
9 1/13/2011 7:00:00 AM 47.803 4781 25673 25.67 10598
510 /1472011 49475 49475 24806 24806 12063
S11 1/17/2011 7:00:00 AM 47.001 46.998 26.111 26.113 10.007
S12 1/18/2011 7:00:00 AM 46956 4694 26137 26146 9979
513 1/19/2011 7:00:00 AM 47.365 47.366 25911 2591 10306
514 1/20/2011 7:00:00 AM 47955 4793 25592 25606 10702
s15 1/21/20117:00:00 AM 49559 49541 24764 24773 12103
516 1/24/2011 7:00:00 AM 46971 46971 26128 26128 999
Back 517 1/25/2011 7:0000 AM 47275 47.248 259 25975 10095 Next

518 1/26/2011 7:00:00 AM 47366 47372 2591 25907 10308
519 1/27/20117:00:00 AM 48035 48039 2555 25548 10662
S20 1/28/20117:00:00 AM 49487 49483 248 24802 12068
S21 1/31/2011 7:00:00 AM 4725 47.224 25974 5.989 10.08
22 2/1/2011 7:00:00 AM 5103 5099 2405 4,066 13125
523 2/2/2011 7:00:00 AM 50968 5095 24079 4,088 13163
524 2/3/2011 7:00:00 AM 836 51829 23676 3679 13751
525 2/4/2011 7:0000 AM 108 57094 1491 496 16557
526 2/7/2011 7:00:00 AM 531 50542 24,288 262 13011
521 2/8/2011 7:0000 AM 035 50322 4375 388 12859
528 2/9/20117:00:00 AM 127 51266 3937 939 13374
529 2/10/20117:00:00 AM 5089 50893 24116 24115 13475
530 2/11/20117:00:00 AM 56756 56734 21624 21632 1642
si 2/14/2011 7:0000 AM 50046 50042 24523 24525 12711
S22 2/15/20117:00:00 AM 50951 50944 24087 24091 13084
s33 2/16/2011 7:00.00 AM 50402 0401 2435 2435 13047
534 2/17/2011 7:00:00 AM 51207 1199 23967 23971 13599
535 2/18/2011 7:0000 AM 77 7387 2127 21386 16753
536 2/21/2011 7:00:00 AM 103 1016 240 24057 13127
537 2/22/20117:0000 AM 62176 2.108 19739 1976 14102
$38 2/23/20117:00:00 AM 51247 51226 23948 23958 1336 -
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TART BASE ANALYSIS WEATHER DEMAND INCIDENT SCENARIOS EVENTS SUMMARY REPORT

HCS Streets Rellability Report
\Imtm Properties
“Anaiyst T Toursacton T Thgency T
Time Analyzed T TAnatysis Year I [pate I |
[Project Description
Base Dataset Analysis
T Date | 9/17/2024 12:00:00 AM] Base Dataset Analyst |
[Start Time 07:00 | End Time I 07:15 | Period Duration || 00:15
Number of Periods 1 Tintersectons I 2 [Segments I T
[Comments Chapter 30: Example Problem 1
| Reliability Input Summary
Reporting Start Date 1172011 | Reporting End Date | 1172012 |
‘Analysis Days 260 [Weather Locaion | GAINESVILLE.FL | T Weather | Demand | incident
ban Street Class UrbanPrinipal | Base Demand Rato | 0076 [mowee | v | v | v
Shouider Presence Yes Number of Repiications| 1 Seed 52 7 53
| Reliability Performance Measure Results East Bound West Bound
Vehicie miles raveled (veh.m) 20645 20646
| Number of Scenarios 260 260
| Base free-flow travel time (s) 30.095 30.095
|MeanTTI 172 1.74
B01h percentie TT1 1762 1762
Back | [95th percentle TT1 (PT)) 1961 1961
[Rellabity rating (%) 100 100
Total ddai (veh-h) 1347 |
Replication Average TT 95ih Percentle TT Average TT 95th Percentle TT
1 51768 59014 51761 55,005
[Average 1768 50014 S1761
| Standard deviation [] [] 0
[95t% Confidence interval 51.768-51.768 59.014-50.014 51.761-51.761
|_caoos-sa005 |
0% 0% 0% 0%
‘Travel Time Frequency Distribution (Forward)
50 51 52 53 54 55 56 57 58
Travel Time (sec)
Travel Time Frequency Distribution (Reverse)
60 - ! | ! | | =
9 Switch to Text Report W - -+

Copyright © 2024 University of Florida. All Rights Reserved. HCS™ Streets Reliability Version 2025 (USC)

View Results of the Analysis

1. After editing all the necessary inputs and generating scenarios, results of the analysis can be found in the
form of tables on the Events and Summary pages, and in the form of reports on the Report page.

Rl

START BASE ANALYSIS WEATHER DEMAND INCIDENT SCENARIOS SUMMARY REPORT

Repiication |1~
(%) Event predictions
Scenarios per page: 20 ~
= T
= i e
/472011 7:00:00 AM Ory 1000 No
1/5/2011 7:00:00 AM Ory 1020 No
1/6/2011 7.00:00 AM Dry 1051 No.
1772011 7.00:00 AM Dry 1173 No
Ory 1000 No
Ory 1000 No
Ory 1020 No
1/13/2011 7.00:00 AM Ory 051 No
1/14/2011 7:00:00 AM Ory REE) No
1/17/2011 7:00:00 AM Dry 000 No
k 1/18/2011 7.00:00 AM Ory 000 No
1/19/2011 7:00:00 AM Dry 1020 No
| Back: 1/20/2011 70000 AM Dry 1051 No Next
1/21/2011 7:00:00 AM Dry 1173 No
1/24/2011 700,00 AM. Dry 1000 No
1/25/2011 7:00:00 AM Ory 1000 No
1/26/2011 7.00.00 AM. Dry 1020 No
Ory 1051 No
1/28/2011 7:00:00 AM Dry 117 No
ious. Current Page: 1/13 | Next> | Last
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Replication 1~

sl 1/3/2011 7:00:00 AM
2 /472011 7:00:00 AM
S3 1/5/2011 7:00:00 AM
4 1/6/2011 7:00:00 AM
) 1/7/2011 7.00:00 AM
1/10/2011 7:00:00 AM.
7 1/11/2011 7:0000 AM
1/12/2011 7:00:00 AM.
55 1/13/20711 7.00:00 AM
si0 1/14/3011 7:00:00 AM
sl _VlTIZDU 7:00:00 AM 2059 52055
EE 1/18/2011 7:00:00 AM 195 51929
s13 1/19/2011 7:00:00 AM 3413 53414
Sl | 1/20/2011 7:00:00 AM 5033 54996
@ 515 1/21/2011 7:0000 AM 62472 62432 @
[_st6 [vedpon7ooooAm| 51998 51.997
Back S17 1/25/2011 7:00:00 AM 52198 52166 Next
518 1/26/2011 7:00:00 AM 53418 53427
518 1/27/2011 7.00:00 AM 54855 54861
S0 1/28/2011 7:00,00 AM 62377 62364
221 173172011 7:00:00 AM 236 52124
522 /172011 7:00:00 AM 8.62 68,681
523 2/2/2011 7:00:00 AM 207 63125
17:00:00 AM 73488 73444
525 2/4/2011 7:00:00 AM 01313 100988
526 2/7/2011 7:00:00 AM 68072 8812
2/8/2011 70000 AM 67.015 663
28 2/3/2011 7.06:00 AW 70232 7047
529 2/10/2011 7.00:00 AM 7154 71550
[ s [2/11/2011 70000 AM 99013 98491
sl 2/14/2011 7:00:00 AM 66,641 66626
532 2/15/2011 7.00:00 AM 68631 eBE01
511 2/16/20117.00,00 A 62,003 68,006
s34 2/17/2011 70000 AM EEREL] 73124
535 2/18/2011 70000 A 103619 106002 11621 11578 328
Si6 2/21/2011 70000 AM 68777 68718 17844 1786 2134
517 2/22/2011 7:00.00 A 91035 90555 13.481 13553 525
2/23/2011 70000 AM 70457 70354 17409 17434 23118 -

SIS WEATHER DEMAND INCIDENT SCENARIOS EVENTS SUMMARY

HCS Streets Rellability Report

i
g|

Anatyst J [ Junsdiction [ Eg:r\:y | &
| Anaiysis ear | Dais |
Project Description
Base Dataset Analysis
Base Dalaset File SueelsBase! sus | Daa Collection Date | 1/4/2011 12.00.00 AM | |
Saniwe | 5700 {End Tme I o715 T 5
Number of Perods i Tiersectons I 2 [ Sagments 1 g

|

I Input Summ
Reporting Stan Date izt | Reporing EnaOae | e Ao
Analysis Days [ 260 Vieaiher Location | GAINESVILLE. FL T Weainer | Demand | inckent
rban Sireet Class UrbanPrincipal | Base Demand Ratin 0% ude ¥ v Y
Shouoer Presence | _____Ves | Numberof Repecaonsl 1 ____seec | szl 11 &
oy East Bound Wes! Bound
| Vehice mies traveicd vebm) 26952 2058
B S {5 )
Base free-fow travel ime (5] 30,085 30065
foan 111 748 2481
50 percentle TT1 2048 2080
95 porcentie TT1 (511} 3461 3467
Refianity rating (%) 56,506 o7 287
Total ey (vehh) 35273
Rapiication Average 6m Percentie TT Average 7T ‘550 Percentle 1T
¥ 73813 704287 04348
Lol B
Ave 73813 1627 X 04348
| Stancard deviation 0 I |
TABIA- 73813 | 104387 - 104357 04 548 - 104548
% o

76 B0 84
Travel Time (sac)

Travel Time Frequency Distribution (Reverse)

T l } A | } | | J

Switch to Text Repart i —
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2. There are two options for reports: Formatted and Text

a. Formatted reports show the most important results in a presentable format.

HCS Streets Reliability Report

Time Anal | [ Analysis Year | | Date |

Project Description

Base Dataset Analysis

Base Dataset File

Start Time 15

Number of Periods 1 | 7 | [ Segments i 1
Comments

Reliability Input Summary

Reporting Start Date 172011 Reporting End Date | 1172012 Random Seed Summary

Analysis Days 260 Weather Location | GAINESVILLE, FL | Weather | Demand | Incident
Urban Street Class UrbanPrincipal | Base Demand Ratio | 0073 indude | Y Y Y
Shoulder Presence Yes Number of Replications| 1 Seed 82 11 63
Reliability Performance Measure Results East Bound West Bound

Vehicle miles traveled (veh-mi) 21379 21366

Number of Scenarios 260 260

Base free-flow travel time (s) 30,095 30.095

Mean TTI 1.769 1.769

80th percentile TTI 1831 1.832

'95th percentile TT1 (PT1) 2074 2074

Reliability rating (%) 100 100

(veh-h) 14247
lication Average TT 95th Percentile TT Average TT 95th Percentile TT
1 53.227 62428 53229 62.416
= ks e
Average 53.227 62428 53229 62416
Standard deviation 0 0 0 0
95th% Confidence Interval 53.227 - 53.227 62428 - 62.428 53229-53229 62416 -62416
0% 0% 0%
Travel Time Frequency Distribution (Forward)
|

&% \

333 |

g 22

o ]

8 50 52 54
Travel Time (sec)
Travel Time Frequency Distribution (Reverse)

255 L

g a4

$33 |I II

22-
= | f=— T W =
48 50 52 54 56 58 60 6! 64
Travel Time (sec)

b. Text reports show a more detailed analysis in plain text.

HCS Streets Reliability Text Report

Project Properties

Analyst
Jurisdiction
Agency

Time Analyzed
Analysis Year
Da

o
Project Description

Performance Measure EAST BOUND VALUES
Vehicle Miles Travelled (veh-mi) 21379

Base Free-Flow Speed (mi/h) 0.78

Base Free-Flow Travel Time (s) 30095
Reliability Rating 100

umber of Scenarios 260

Replication 1 :

Random Number Seeds Weather Demand Incident
52 11 63
Travel Travel Stop Running Through Total
Time Speed Rate Time Delay Delay
(=) (mi/h)  (stops/veh) ) (s/veh) (veh-hr)
Average 53.227 2318 1.695 33.652  19.576  14.247
Standard Deviation 4.07 1.612 0.223 0.591 3.704 2.093
Skewness 1489 Siaee 1426 6.103  1.512  1.032
Median 5i.085 230608 1.617 33.556 18.415 13.83
Sth Percentile 48.536 19.659 1.463 33.186 15.361 1
10th Percentile 49,878 200587 1.509 33.334  16.503 12.305
80th Percentile 55.117 24.329 1.812 33.776 21.371 15.376
85th Percentile 57.202 24.486 1.936 33.855 23.383 16.458
95th Percentile 62.428 25.286 2.172 34.087 27.375 18.416
Performance Measure WEST BOUND VALUES
Vehicle Miles Travelled (veh-mi) 21366
Base Free-Flow Speed (mi/h) 20.78
Base Free-Flow Travel Time (s) 30.095
Reliability Rating 100
Number of Scenarios 260
Replication 1 :
Random Number Seeds Weather Demand Incident
82 1 63
Travel Travel Stop Running Through Total
Time Speed Rate Time Delay Delay
) (mi/h) (stops/veh) ) (s/veh) (veh-hr)
Average 53.229 23,179 1.695 33.652  19.577  14.247
Standard Deviation 4.074 1.612 0.224 0.592 3.707 2.093
Skewness. 1.493 -1.137 1.432 6.105 1.515 1.032
dian 51.97 23.615 1.617 33.557 18.417 13.83
Sth Percentile 48.542 19.663 1.463 33.188 15.369 11.061
10th Percentile 49.865 20.561 1.509 33.336 16.514 12.305
80th Percentile 55.143 24.329 1.813 33.776 21.394 15.376
85th Percentile 57.204 24.488 1.936 33.855 23.397 16.458
95th Percentile 62.416 25.283 2.175 34.087 27.383 18.416

Streets Reliability Text Report was created in HCS™ Streets Reliability Version 2024 on October 16, 2023 at
9:39.

Streets Reliability User Guide

How To - 39



3. The type of report displayed can be changed by using the main menu items, keyboard shortcuts, or toggle
buttons found under the report

a. Main Menu ltems

i. To switch to the Formatted Report, select File > Report > Formatted Report from the main
menu; this can be found by selecting the three lines in the top left-hand corner of the
screen, hovering over “Report”, and then selecting “Formatted Report”.

2 SueetsReliabilty Lt - HCS Sreets Refabiity - o x

= START BASE ANALYSIS WEATHER DEMAND INCIDENT SCENARIOS EVENTS SUMMARY REPORT
Nev visN
HCS Streets Reliability Report
Uit
print
printP :
Report [ [romaneareport 74
T Text Report
Help , [zon— [Reporing End Bate 3512 Random Seed Summary
o — GANESVLE T Weatbr | Dt | Tho
Exit Alt+F4 DrbanPrincipal 2mand Ratio 0.058 [inciude i T Y
S peseree 5 Numberot eptcasers] ; [Sees 2
Eastbowna West Bownd
2oz Zovzs
o 0
oo s
F £
Zois oot
St o
[ 27
FFe
Aeerge T | G5 Porcende T | Aveage TP | 65 Parcete T
Tors iz e s
o e oz T o
Siangard sovizion o o G o
T e | oid . iz | 7977 TaTeT | 101, o
F3 o o o
Travel Time Frequency Distribution (Forward)
225
|

64

L 1 11 7] | [ e e
o — AN, .

[ —
00 104 108
Travel Time (sec)

Travel Time Frequency Distribution (Reverse) |
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i. To switch to the Text Report, select File > Report > Text Report from the main menu; this
can be found by selecting the three lines in the top left-hand corner of the screen, hovering
over “Report”, and then selecting “Text Report”.

= SueetsRelobilty Lt - HCS Streets Refiabity - o X

= START BASE ANALYSIS WEATHER DEMAND INCIDENT SCENARIOS EVENTS SUMMARY REPORT

New

3 2.2
5" 14063

b. Keyboard Shortcuts
i. Formatted Report: keyboard shortcut is “F4”
ii. TextReport: keyboard shortcut is “F6”

c. Report Toggle Buttons

i. Atoggle button is available at the bottom of the screen underneath the report.
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If the formatted report is currently being displayed, the toggle button will say “Switch to Text
Report” which will allow you to display the text report if clicked.

START BASE AMALYSIS WEATHER DEMAND INCIDENT SCENARIOS EVENTS SUMMAR'

HCS Streets Reliability Report

8 Perpate TT Ausrage 7T 8 Porcersle T
Taa 287 TaTeT )
T 73767

‘Travel Time Frequency Distibution (Forward)

R i [ (R ey
I — ﬂhﬁi‘%ﬂmﬁﬂlﬂﬂmﬂ P i R —
G e T2 T8 G s e % w10 14 s

2 S 6

25
0
15
1
H

Travel Tims (sec)

Teavel Time Frequency Distribution (Reverse)

If the text report is currently being displayed, the toggle button will say “Switch to Formatted
Report” which will allow you to display the formatted report if clicked.

= START BASE ANALYSIS WEATHER DEMAND INCIDENT SCENARIOS EVENTS SUMMARY REF

bes syt wullabiTity

aandca wsber Seeds v Domand T
a
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o

s
a
e
$in Parcentite
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4. The magnification of the report currently being displayed can be changed using the zoom slider found at

the bottom rlght-hand corner of the screen.

START BASE ANALYSIS WEATHER DEMAND INCIDENT SCENARIOS EVENTS SUMMARY RE

HCS Streets Reliability Report

Project Froperties

Anaiyst I  utisdiction T
[Time Analyzed [ [ Bnaiysis Yeat 1
[Project Bescapion

Agency |
Date |

i

| Base Dataset Analysis
Base Dataset Fio SiroeimBase! s | Gaia Collecton Date | 1420711 12:00-00 AM | Base Dataset Anayst |
Start Tume. o700 | End Time | o718 | | 00:18
Number of Periogs T [intersectons I 2 [ Segmens. [ T
"Gomments
_
Raliabi
Reportng Start Dafe An7o Reporting End Dotz | 012 Ranaom seed
o | Weather Location | GAINESVILLE, FL_| | Weather | Demand | Incident
fban Sireet Glass UrbanPrivcipal | Base Demond Fata | G058 Tincuge | ¥ | ¥ |
Shouider Presence Ve Nuamber o i ] Seed 2 i) ()
Reliabilty Parformance Mesturs Results East Bound West Bound
Vehice maes traveied (veh.mmi) 26932 20928
Numiber of Scenarios 260 20
) Base free-fow travel ime (5) 30.096 o5
[Mean TT1 FYE) 451
I B0th percentie TT1 2648 e
Back 96th percentde TT1 (PT)) 3464 467
Reiabilty rating (%) 66 406 287
Total Geiay ivet-h) 25213
Raplication Average TT 50 Percente TT Average TT S5 Percentle TF
1 7813 104,257 7367 104348
verage 7361 04257 73787 «oam
Standard oeviation a ] 1 === —_—
o mm 73813 o4 m 04257 nm Tazer_| |o4m mua

Travel Time Frequency Distribution (Forward)

K ‘
%,52‘*; 1 & “ I — - T
Flye o gl ikl it . . ol we o .
52 56 60 64 &8 72 % 80 84 88 92 9% 100 104 108
Travel Time (sec)
Travel Time Frequency Distribution (Reverse) ‘
25 n

iravessity of Flarida. All Rights Reserved,

Switch to Text Report

a. Tozoom in, drag the slider to the right; to zoom out, drag the slider to the left

b. Clicking the plus (+) button will zoom in; clicking the minus (-) button will zoom out

c. Holding down “ctrl” on the keyboard and scrolling up on the mouse wheel will zoom in; holding
down “ctrl” on the keyboard and scrolling down on the mouse wheel will zoom out

Print a Report

1. There are four options for printing a report:

a. Selecting File > Print from the main menu; this can be found by selecting the three lines in the top
left-hand corner of the screen and then selecting “Print”

= SteetsRelbiity e - HCS Srets Reabilty

= START BASE ANALYSIS WEATHER DEMAND INCIDENT SCENARIOS EVENTS SUMMARY REPORT

New CulsN
o S HCS Streets Reliability Report
Example Folder eliability Repor

Save

Save As. Juridicion Togeos T
[ Analysis Year | [ate |

Close oW

Units .
[ print Cillop|reeisBaset xus | Data Colecton Date | 1412011 12:00:00 AM | Ba T

" Print Preview CtioF 0700 [EndTime [ o715 [Period Duraton | £33
T [imersectons I 2 [Segments T T
Report

Default Settings

Help » nmon Reporting End Date 1172012 Random Seed Summa
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2. Print

a.

Selecting File > Print Preview from the main menu; this can be found by selecting the three lines in
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Using keyboard shortcut “Ctrl+P” for Print
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3. Print Preview

a.

Using Print Preview will bring up a window where you can view how the report will look on paper
before sending it to the printer
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Glossary of Terms

50t Percentile TTI

The ratio of the 50" percentile highest travel time to the travel time at the base free-flow speed. This measure can
be used for trend analysis and to demonstrate changes in performance resulting from an operational strategy,
capacity improvement, or change in demand.

80t Percentile TTI

The ratio of the 80" percentile highest travel time to the travel time at the base free-flow speed. This measure has
been found to be more sensitive to operational changes than the PTI, which makes it useful for comparison and
prioritization purposes.

95t Percentile TTI
See Planning Time Index (PTI).

Agency

This field is provided to document the agency or company associated with this analysis or project.

Analysis Period

The time interval used for the performance evaluation. It can range from 15 min to 1 h, with longer durations in this
range sometimes used for planning analyses. A shorter duration in this range is typically used for operational
analyses.

Analysis Year

This field is provided to document the year for which the analysis is being performed.

Analyst

The field is provided to document the name of the analyst.

Annual Delay

Annual delay represents the average vehicle hours of travel or person hours of travel occurring minus what would
occur under free-flow conditions. Delay is useful because economic analyses have a long history of monetizing
delay.
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Base Crash Frequency

The methodology requires the base crash frequency for each segment and for each intersection along the subject
facility. The base crash frequency is an estimate of the expected crash frequency for the segment or intersection
when no work zones are present or special events occur. The estimated should include all severity levels, including
property-damage-only (PDO) crashes. Crash frequency is provided in units of crashes per year, regardless of the
duration of the reliability reporting period.

Base File

The base file provides all the required input data for the urban street segments methodology described in HCM
Chapter 18. The base file contains the required input data to execute HCM Chapter 17’s reliability methodology. It
consists of all the data needed to evaluate the base HCM facility methodology for a single study period, plus data
that describe the variations in demand, weather, and so forth that occur over the course of the reliability reporting
period, along with the frequency of a particular event’s occurrence. The majority of the reliability-specific input data
can be defaulted when they are not available locally, but the analyst is encouraged to supply facility-specific data
whenever feasible.

The user has the option to load a base file or create a base file. Clicking on ‘Load Base File’ will open a dialog box
to allow the user to select a Streets (*.xus) file for the user to open and load into the Streets Reliability program.
Once loaded, a Street intersections and segments graph of the base file will be displayed on the page, along with
general information. Clicking on the ‘Create Base File’ will open the HCS Streets program to allow the user to create
a new base file for use in the Streets Reliability program.

Please also see Data Depository.

Crash Frequency Adjustment Factors for Inclement Weather

Inclement weather conditions can increase the likelihood of crashes. Crash frequency adjustment factors are
required for the following conditions:

e Rainfall,

e Snowfall,

e Wet pavement (not raining), and

e Snow or ice on pavement (not snowing).

The crash frequency adjustment factor is the ratio of hourly crash frequency during the weather event to the hourly
crash rate during clear, dry hours. It is computed by using one or more years of historical weather data and crash
data for the region in which the subject facility is located.

The adjustment factor for a specific weather condition is computed from (a) the number of hours for which the
weather condition exists for the year and (b) the count of crashes during those hours. An hourly crash frequency
for the weather condition f;wes is computed by dividing the crash count by the number of hours. By a similar
technique, the hourly crash frequency is computed for dry pavement hours f. 4. The crash frequency adjustment
factor for the weather condition CFAFues is computed as the ratio of the two frequencies (i.e., CFAFwea = fc wealfc,dry)-

The crash frequency adjustment factor includes consideration of the effect of the weather even on traffic volume
(i.e., volume may be reduced because of bad weather) and on crash risk (i.e., wet pavement may increase the
potential for a crash).

The following are the default values for the crash frequency adjustment factor of each weather condition:
e Rainfall: 2.0
e Wet pavement (not raining): 3.0
e Snowfall: 1.5

e Snow or ice on pavement (not snowing): 2.75
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Crash Location Categories

The categorization of crashes by location is determined by using the definitions given in Highway Safety Manual
(HSM) Section A.2.3, found in Appendix A of HSM Volume 2. The HSM states that “Intersection crashes include
crashes that occur at an intersection (i.e., within the curb limits) and crashes that occur on the intersection legs and
are intersection related. All crashes that are not classified as intersection or intersection-related crashes are
considered to be roadway segment crashes.”

Data Depository

Every reliability analysis requires a base dataset. This dataset describes the traffic demand, geometry, and signal
timing conditions for the intersections and segments along the facility during the study period, when no work
zones are present and no special events occurs.

Please also see Base File.

Date

This field is provided to document the date when the analysis is performed.

Day-of-Week Demand Ratios
The following HCM exhibit provides the default day-of-week demand ratios (ADT/AADT):

Day Demand Ratio
Sunday 0.87
Monday .98
Tuesday 0.98

Wednesday 1.00
Thursday 1.03
Friday 1.15
Saturday (.99

Source: Hallenbeck et al. ().

See also Time Period Adjustment Factors.

Demand Change Factors

The three “demand change factors” account for a change in traffic demand due to weather conditions. One factor
describes demand change during dry weather (by definition it has a values of 1.0). A second factor describes the
demand change during a rain event. The third factor describes the demand change for a snow event. During a step
of the methodology, the demand volume is multiplied by the demand change factor corresponding to the weather
associated with a given analysis period. A factor less than 1.0 corresponds to a reduction in demand during the
event.

Research indicates that urban street traffic demand tends to drop 15% to 30% during snow events. These motorists
likely altered the start time of their commute or stayed home to avoid the bad weather. In the absence of local data,
a default value of 0.80 may be used for snow events.

The research is less clear on the effect of rain on traffic demand. The effect of rain may vary with the trip purpose
and the annual frequency of rain events in the vicinity of the subject facility. A default factor values of 1.0 is
recommended for rain events. These default values are summarized in the following HCM exhibit:
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Input Data Item Default Value

Demand change factor for dry weather 1.00
Demand change factor for rain event 1.00
Demand change factor for snow event 0.80
Pavement runoff duration for snow event 0.5 h

See Duration of Pavement Runoff for the input data item in the last row.

Demand Pattern Data

Demand pattern data are used by the reliability method to adjust the demand volumes in the base and alternative
datasets to reflect demands during all the other time periods in the reliability reporting period. The data include (a)
adjustment factors to account for demand variation by hour of day, day of week, and month of year; and (b)
adjustment factors to account for change in traffic demand due to weather conditions.

Details per page

A drop down selection is provided to indicate how many scenario results to show on the page.

Duration of Pavement Runoff

The duration of pavement runoff for a snow event is required. It is defined as the period of time after the snow stops
falling that snowpack (or ice) covers the pavement. After this time period elapses, the pavement is exposed and
drying begins. This time is likely a function traffic volume, snow depth, and agency snow removal capabilities. An
appropriate local value should be established for the subject facility if that is possible. If such a value is not available,
the default value provided in the last row of the HCM exhibit can be used. See Demand Change Factors for the
exhibit.

Facility Evaluation

The facility evaluation stage consists of two tasks that are repeated in sequence for each analysis period. The
analysis periods are evaluated in chronological order.

First, the dataset associated with a given analysis period is evaluation by using the urban street facility methodology.
The performance measures output by the methodology are then archived.

Second, the dataset associated with the next analysis period is modified, if necessary, on the basis of the results
of the current analysis period. Specifically, the initial queue input value for the next analysis period is set equal to
the residual queue for the current analysis period.

Failure or On-Time Measures

The percent of trips (or percent of time) with space mean speeds above (on time) or below (failure) one or more
target values (e.g., 35, 45, and 50 mi/h; or 56, 72, 80 km/h in metric). These measures address how often trips
succeed or fail in achieving a desired travel time or speed.

Functional Class

The functional class of the subject facility is a required input when the analyst chooses to use the default time period
adjustment factors. These factors are used for estimating the traffic volume during each of the various scenarios
that make up the reliability reporting period.

The following functional classes are considered:
e Urban expressway,

e Urban principal arterial street, and
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e Urban minor arterial street.

An urban principal arterial street emphasizes mobility over access. It serves intra-area travel, such as that between
a central business district and outlying residential areas or that between a freeway and an important activity center.
It is typically used for relatively long trips within the urban area or for through trips that enter, leave, or pass through
the city. An urban minor arterial street provides a balance between mobility and access. It interconnects with and
augments the urban principal arterial street system. It is typically used for trips of moderate length within relatively
small geographic areas.

The methodology addresses roadways that (a) have one of the aforementioned classes and (b) do not have full
access control. If a roadway has full access control then it is considered to be a freeway and the analyst should use
the Freeway methodology.

Hour-of-Day Demand Ratios
The following HCM exhibit provides the default hour-of-day demand ratios (ADT/AADT):

Hour Expressway Principal Arterial Minor Arterial
Starting Weekday Weekend Weekday Weekend Weekday Weekend
Midnight 0.010 0.023 0.010 0.023 0.010 0.028

1am. 0.006 0.015 0.006 0.014 0.006 0.023

2 a.m. 0.004 0.008 0.005 0.010 0n.004 0.021

3 a.m. 0.004 0.005 0.005 0.006 0.002 0.008

4 a.m. 0.007 0.005 0.009 0.006 0.002 0.005

2 a.m. 0.025 0.009 0.030 0.010 0.007 0.005

b a.m. 0.058 0.016 0.054 0.017 0.023 0.011

7 a.m. 0.077 0.023 0.071 0.024 0.067 0.018

8 a.m. 0.053 0.036 .058 00.035 0.066 0.030

9 a.m. 0.037 0.045 0.047 0.046 0.054 0.048
10 a.m. 0.037 0.057 0.046 0.056 0.051 0.054
11 a.m. 0.042 0.066 0.050 0.054 0.056 0.057

MNoon 0.045 0.076 .053 0.071 0.071 0.074

1 p.m. 0.045 0.073 0.054 0.071 0.066 0.071

2 p.m. 0.057 0.074 0.063 0.072 0.060 0.069

3 p.m. 0.073 0.075 0.069 0.073 0.062 0.067

4 p.m. 0.087 0.075 0.072 0.073 0.063 0.071

5 p.m. 0.090 0.071 0.077 0.073 0.075 0.068

6 p.m. 0.068 0.063 0.062 0.063 0.070 0.067

7 p.m. 0.049 0.051 0.044 0.052 0.053 0.056

8 p.m. 0.040 0.043 0.035 0.044 0.044 0.049

9 p.m. 0.037 0.037 0.033 0.038 0.035 0.040
10 p.m. 0.029 0.032 0.026 0.033 0.033 (1.035
11 E.m. 0n.019 0.023 0.021 0.026 0n.019 0.024

Source: Hallenbeck et al. (4.

See also Time Period Adjustment Factors.

Incident Clearance Time

The Time from the arrival of the first response vehicle to the time when the incident and service vehicles no longer
directly affect travel on the roadway. This time varies by incident location, type, and severity. Clearance times are
weather-dependent. Incident clearance times are reported in minutes and for street location (segment or
intersection), incident type (crash or noncrash), lane location (shoulder, one lane, two or more lanes), severity
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(fatal/injury or PDO), and weather condition (dry, rainfall, wet pavement, snowfall or snow or ice on pavement) (96

total values).

Default values for incident clearance time are provided in the following HCM exhibit:

Clearance Time by Weather Condition {min)

Street Event Lane Rain- Wet Snow
Location Type Location Severity” Dry fall Pavement Or Ice’®

Segment Crash  One lane FI 56.4 421 43.5 76.7

FPDO 39.5 28.6 29.7 53.7

2+ lanes FI 56.4 42.1 43.5 76.7

PDO 39.5 28.6 29.7 53.7

Shoulder FI 56.4 42.1 43.5 76.7

PDO 39.5 28.6 29.7 53.7

Non- One lane  Breakdown i0.8 5.6 5.7 14.7

crash Other 6.7 2.4 2.8 9.1

2+ lanes  Breakdown 10.8 5.6 5.7 14.7

Other b.7 2.4 2.8 9.1

Shoulder Breakdown 10.8 5.6 5.7 14.7

Other 6.7 2.4 2.8 9.1

Signalized Crash  One lane FI 56.4 421 435 76.7

intersection PDO 39.5 28.6 29.7 53.7

2+ lanes FI 56.4 42.1 43.5 76.7

PDO 395 28.6 29.7 53.7

Shoulder FI 56.4 42.1 435 76.7

PDO 395 28.6 29.7 53.7

Non- One lane  Breakdown 10.8 5.6 5.7 14.7

crash Other 6.7 2.4 2.8 0.1

2+ lanes  Breakdown 10.8 5.6 5.7 14.7

Other 6.7 2.4 2.8 9.1

Shoulder Breakdown 108 5.6 5.7 14.7

Other 6.7 2.4 2.8 9.1

Source: Zegeer et al. (1),

Motes:

“ FI = fatal or injury crash; PDO = property-damage-only crash.

5 applies to snowfall and to snow or ice on pavement (but not snowing).

Incident Detection Time

The time period starting with the occurrence of the incident and ending when the response officials are notified of
the incident. Incident detection time is reported in minutes. The default incident detection time for all weather
conditions is 2.0 minutes.

Incident Location Distribution

The incident location distribution is used by the incident generation procedure to assign incident to specific locations
on the facility. Research indicated that this distribution varies by incident location, type, and severity. The following
incident proportions are required:

e Proportion of crash and noncrash incidents by street location (segment or intersection) (four total values);
proportions should total 1.000 for a given street location;

e Proportion of shoulder, one-lane, and two-or-more-lane incidents by street location and event type (crash
or noncrash) (12 total values); proportions should total 1.000 for a given street location and event type
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combination; a 0.000 proportion should be assigned to values involving a shoulder location if no shoulders
exist on the facility;

e Proportion of fatal/injury and PDO crashes by street location and lane location (12 total values); proportions
should total 1.000 for a given street location and lane location combination; and

e Proportion of breakdown and other noncrash incident by street location and lane location (12 total values);
proportions should total 1.000 for a given street location and lane location combination.

The four proportions identified in the previous list are multiplied together to obtain the desired incident location
distribution factors. One factor is obtained for each combination of street location, incident type, incident location,
and incident severity. The computed factors should total 1.000 for a given street location.

The default incident distribution with shoulder presence is provided in the following HCM exhibit:

Incident Type Incident Location Incident Severity

Street Pro- Lanes Pro- Pro- Joint
Location Type portion Affected portion | Severity” portion | Proportion

Segment Crash 0.358 1 lane 0.335 FI 0.304 0.036

PDO .696 0.083

2+ lanes 0.163 FI 0.478 0.028

PDO 0.522 0.030

Shoulder 0.502 FI 0111 0.020

PDO ().889 0.160

Non- 0.642 1 lane 0.849 Breakdown (1.836 0.456

crash Other (.164 0.089

2+ lanes 0.119 Breakdown 0.773 0.059

Other 0.227 0.017

Shoulder 0.032 Breakdown (.667 0.014

Other (0,333 0.007

Total: 1.000

Signalized Crash 0.310 1 lane 0.314 FI 0.378 0.037

intersection PDO 0.622 0.061

2+ lanes (0.144 FI 0.412 0.018

PDO 0.588 0.026

Shoulder 0.542 FI 0.109 0.018

PDO 0.891 0.150

Non- 0.690 1 lane 0.829 Breakdown (1.849 0.486

crash Other 0.151 0.086

2+ lanes 0.141 Breakdown (1.865 0.084

Other 0.135 0.013

Shoulder 0.030 Breakdown .875 0.018

Other 0,125 0.003

Total: 1.000

Source: Zegeer et al. ( I).
Mote: “FI = fatal or injury crash; PDO = property-damage-only crash; other = not breakdown (e.g., debris).
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The default incident distribution without shoulder presence is provided in the following HCM exhibit:

Incident Type Incident Location Incident Severity

Street Pro- Lanes Pro- Pro- Joint
Location Type portion | Affected portion | Severity® portion | Proportion

Segment Crash .358 1 lane .837 FI 0.304 0.091

PDO .696 (1.209

2+ lanes 0.163 FI .478 0.028

PDO 0.522 0.030

Non- 0.642 1 lane 0.881 Breakdown (0.836 0.473

crash Other 0.164 0.093

2+ lanes 0.119 Breakdown 0.773 0.059

Other 0.227 0.017

Total: 1.000

Signalized Crash 0.310 1 lane (1.856 FI .378 0.100

intersection PDO .622 .165

2+ lanes 0.144 FI 0.412 0.018

FDO (1.588 .026

Non- 0.690 1 lane 0.859 | Breakdown  0.849 0.503

crash Other (.151 0.089

2+ lanes .141 Breakdown ().865 0.084

Other 0.135 0.013

Total: 1.000

Source: Zegeer et al. (I).
Mote: “FI = fatal or injury crash; PDO = property-damage-only crash; other = not breakdown (e.g., debris).

Incident Query

For event predictions, the user can set parameters to check for incidents “starting” at the query hour. The date,
time, and segment/intersection must be specified. Then a ‘Query’ button can be selected, which will display any
incidents for that query.

Incident Response Time

The time period from the receipt of incident notification by officials to the time the first response vehicle arrives at
the scene of the incident. This time will likely vary among jurisdictions and facilities, depending on the priority placed
on street system management and the connectivity of the street system. Response times are weather-dependent.
Incident response times are reported in minutes and for five weather categories (dry, rainfall, wet pavement,
snowfall, snow or ice on pavement).

The following are the default response times for the five weather categories:
e Clear, dry: 15.0 min
e Rainfall: 15.0 min
o Wet pavement (not raining): 15.0 min
e Snowfall: 20.4 min

e Snow or ice on pavement (not snowing): 20.4 min

Jurisdiction

This field is provided to document any jurisdiction convention or project related information.
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Mean TTI

The ratio of the average travel time to the travel time at the base free-flow speed. This measure can be used for the
same purposes as the 50" percentile TTI. However; the mean TTI will typically have somewhat higher values than
the 50t percentile TTI because of the influence of rare, very long travel times in the distribution.

Misery Index

This measure is useful as a descriptor of near-worst-case conditions on rural facilities.

Month-of-Year Demand Ratios
The following HCM exhibit provides the default month-of-year demand ratios (ADT/AADT):

Month Expressway Principal Arterial Minor Arterial
January (.802 (0.831 0.881
February 0.874 1.021 (1.944
March (0.936 1.030 1.016
April ().958 ().987 (1.844
May 1.026 1.012 1.025
June 1.068 1.050 1.060
July 1.107 (0.991 1.150
August 1.142 1.054 1.110
September 1.088 1.091 1.081
October 1.069 (0.952 1.036
MNovember (.962 ().992 (1.989
December (0,933 (1.938 (1.903

Source: Hallenbeck et al. {4).

See also Time Period Adjustment Factors.

Nearest City

The nearest city is a required input when the analyst chooses to use the default weather data. The analyst selects
from 284 U.S. cities. Please see Regional Weather for additional information.

Please see Regional Weather for additional information.

Number of Replications

The number of replications indicates the number of times each scenario is generated to minimize any bias that rare
events may cause.

Planning Time Index (PTI)

The ratio of the 95 percentile highest travel time to the travel time at the base free-flow speed. This measure is
useful for estimating how much extra time travelers must budget to ensure an on-time arrival and for describing
near-worst-case conditions on urban facilities. Also 95" Percentile TTI.

Project Description

This field is provided for the user to document the analysis with any information for identification purposes.
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Random Number Seed

A random number seed is used with the Monte Carlo methods in the reliability methodology. A seed is used so that
the sequence of random events can be reproduced. Unique seed numbers are separately established for weather
events, demand variation, and incidents. For a given set of three seed numbers, a unique combination of weather
events, demand levels, and incidents is estimated for each analysis period in the reliability reporting period.

Regional Weather

The nearest city is a required input when the analyst chooses to use the default weather data. The analyst selects
from 284 U.S. cities. A search bar and/or drop down menu is provided for the user to select a city. Once a city is
selected, the ‘Load Regional Weather’ button needs to be selected for city-specific data to be applied to the weather
event statistics table. If certain values need to be overridden, the user has the option to edit the data. However, if
values need to be reset, a ‘Reset to Regional Default’ button is provided to reapply the city-specific values. See
Weather Event Statistics for more information.

Reliability Rating

The percentage of vehicle-miles traveled on the facility associated with a TTI less than 2.50. This threshold
approximated the point beyond which urban street facility travel times become much more variable (i.e., unreliable).

Reliability Reporting Period

The specific days over which reliability is to be computed, for example, all weekends in a year. A typical reporting
period for a reliability evaluation is 6 to 12 months. The period is specified by start and end dates as well as by the
days of week being considered. The reliability reporting period is used with the study period to describe the temporal
representation of the performance measure fully (e.g., average travel time on weekdays from 4:00 to 6:00 p.m. for
the current year).

Replication Selection

A drop down selection is provided to indicate which results to show based on the replication number.

Running Time

The time a vehicle spends in motion.

Scenario

A unique combination of traffic demand, capacity, geometry, and traffic control conditions. It can represent one or
more analysis periods, provided that all periods have the same combination of demand, capacity, geometry, and
control.

Scenario Dataset Generation

The scenario dataset generation procedure uses the results from Scenario Generation, Weather Event Generation,
Traffic Demand Variation Generation, and Traffic Incident Generation to develop one HCM dataset for each analysis
period in the reliability reporting period. Each analysis period is considered to be one scenario. The base dataset is
modified to reflect conditions present during a given analysis period. Traffic volumes are modified at each
intersection and driveway. Saturation flow rates are adjusted at intersections influenced by an incident or a weather
event, and speed are adjusted for segments influenced by an incident or a weather event. Dates and times represent
a common basis for tracking events and conditions from one analysis period to the next.
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Scenario Generation

The scenario generation stage consists of four sequential procedures: (a) weather event generation, (b) traffic
demand variation generation, (c) traffic incident generation, and (d) scenario dataset generation. Each procedure
generates in chronological order the set of analysis periods that make up the reliability reporting period.

Checkboxes are provided to indicate whether or not to include weather, demand, and/or incidents when generating
scenarios. The user can also choose whether or not to randomize demand volume for every analysis period. Once
these are specified, along with the random seed numbers and the desired number of replications, the user can click
the ‘Generate Scenarios’ button to start the scenario generation process.

Semi-Standard Deviation

A one-sided standard deviation, with the reference point at the base free-flow speed instead of the mean. It provides
the variability distance from free-flow conditions.

Shoulder Presence

The indication of the presence of outside (i.e., right-side) shoulders is a required input when the analyst chooses to
use the default incident location data. This input is specified for the facility.

For a shoulder to be considered present, it must be wide enough to store a disabled vehicle (so that the vehicle
does not block traffic flow in the adjacent traffic lane). If on-street parking is allowed, the analyst will need to
determine whether occupancy would need to be less than 30% to provide reasonable assurance of the opportunity
to move a disabled vehicle from the through lanes to an open stall.

Special Event

Short-term events that produce intense traffic demands on a facility for limited periods of time. These demands may
be addressed by temporary changes in the facility’s geometry or traffic control characteristics, or both. Example
special events include major sporting events, concerts, and festivals.

Standard Deviation

The standard statistical measure.

Stop Rate

The average number of full stops per vehicle. A full stop is defined to occur at a signalized intersection when a
vehicle slows to zero (or a crawl speed, if in queue) as a consequence of the change in signal indication from green
to red, but not necessarily in direct response to an observed red indication. A full stop is defined to occur at an
unsignalized intersection when a vehicle slows to zero (or a crawl speed, if in queue) as a consequence of the
control device used to regulate the approach.

Study Period

The time interval (within a day) that is represented by the performance evaluation. It consists of one or more
consecutive analysis periods. A typical study period is 1.0 to 6.0 h in duration and is stated to represent specific
times of the day and days of the week (e.g., weekdays from 4:00 to 6:00 p.m.). If oversaturated conditions occur
during the study period, at least the first analysis period should be undersaturated. The maximum study period
duration is 24 h.

The geometric design elements and traffic control features of the facility must be unchanged during the study period.
Thus, the intersection lane assignments and signal timing plan should be the same throughout the study period. In
addition, if the directional distribution of traffic volume changes significantly during the day, separate study periods
should be established for each time period where the directional distribution is relatively constant.
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Study Section

The length of facility over which reliability is to be computed. Since reliability is computed through traffic only, the
length of the facility should not be so long that through traffic is a low percentage of total traffic on the facility. The
length of facility to be evaluated should be less than the distance a vehicle traveling at the average speed can
achieve in 15 min.

Through Delay

Through delay represents the sum of two delay sources. One source is the delay due to the traffic control at the
boundary intersection. It is called control delay. The other delay is that due to the negotiation of intersection
geometry, such as curvature. It is called geometric delay.

Time Analyzed

This field is provided to document the time frame of the analysis as morning peak, afternoon peak, existing
conditions, future projections, etc.

Time Period Adjustment Factors

The methodology requires day-of-week and month-of-year factors, expressed as ratios of the average day-of-week
and average month-of-year demand. Also required are hour-of-day factors expressed as a percentage of AADT.
The specific factors needed are described in the following list.

e Hour-of-day factors for each hour of the study period (up to 24, but typically six or fewer in practice),
e Day-of-week factors for each day included as part of the reliability reporting period (up to seven), and
e Month-of-year factors for each month included as part of the reliability reporting period (up to 12).

Default hour-of-day, day-of-week, and month-of-year traffic demand adjustment factors are given in HCM exhibits.
The factors should be replaced with data from permanent traffic count stations whenever available for streets that
are similar to the subject facility and located near it. See also Hour-of-Day Demand Ratios, Day-of-Week Demand
Ratios, and Month-of-Year Ratios.

Traffic Counts

The date and time of the traffic count represented in the base dataset is a required input. If the base dataset
demands are computed by using planning procedures, they are assumed to represent average day volumes. In this
case, a date does not need to be provided by the analyst. However, the time of day for which the estimated volumes
apply is still needed. The date and time of the traffic count represented in an alternative dataset is also a required
input.

Traffic Demand Variation Generation

The traffic demand variation procedure identifies the appropriate traffic demand adjustment factors for each analysis
period in the reliability reporting period. A set of factors accounts for systematic demand variation by hour of day,
day of week, and month of year.

Traffic Incident Generation

The traffic incident procedure generates incident dates, times, and durations. It also determines incident types (i.e.,
crash or noncrash), severity levels, and locations on the facility. Location is defined by the intersection or segment
on which the incident occurs and whether the incident occurs on the shoulder, in one lane, or in multiple lanes. The
procedure incorporates weather and traffic demand variation information from the previous procedures in
generating incidents.
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Travel Speed

The ratio of segment length to through-movement travel time.

Travel Time

Travel time is a versatile measure, since it can be monitored over time (for trend analysis), monetized (in calculating
benefits), and used in the calculation of other measures (e.g., delay), Facility lengths usually remain the same over
time, allowing apples-to-apples comparisons of travel times estimated for a facility in different years or under
different circumstances. Travel time is measured in minutes. Travel time is computed as the sum of segment running
time and through-movement control delay at the downstream boundary intersection.

Travel Time Index (TTI)

The ratio of the actual travel time on a facility to the travel time at the base free-flow speed.

Weather Event Generation

The weather event procedure generates rain and snow events during the reliability reporting period. The dates,
times, types (i.e., rain or snow), and durations of severe weather events are generated. These data are used to
adjust the saturation flow rate and speed of facility traffic for each analysis period. The procedure also predicts the
time after each weather event that the pavement remains wet or covered by snow or ice, since the presence of
these conditions influences running speed and intersection saturation flow rate.

Weather Event Statistics

A reliability evaluation requires the weather data identified in the following list. These data represent averages by
month of year for a recent 10-year period

e Total normal precipitation (in., or cm. in metric),

e Total normal snowfall (in., or cm. in metric),

o Number of days with precipitation of 0.01 in. (or 0.025 cm. in metric) or more (days),
e Normal daily mean temperatures (°F, or °C in metric), and

e Precipitation rate (in./h, or cm./h in metric).

Default values for the aforementioned statistics are available from the National Climatic Data Center (NCDC) for
284 locations in the United States.
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